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1. [bookmark: _Toc209000047]Getting Started
Welcome to your new BI X Series Braille display. Please note that throughout this user guide, the generic expression “BI X series” will be used to designate indifferently the BI 20X and the BI 40X. When it is necessary to distinguish one specific device from the other, the device specific model will be indicated.
Please note that the KeyRecorder app is available only on the BI 40X.
This user guide provides instructions for orientation, usage, navigation, and updating of the device. For more information, please refer to the Brailliant BI 20X or the Brailliant BI 40X product page on the HumanWare website or call your nearest HumanWare supplier.
You can always find the most recent version of this document in the User guide application that is present in the main menu of this device. 
Please note: to be sure that your device downloads the most recent version of this user guide when available, please make sure to connect it regularly to Internet.
1.1. [bookmark: _Toc209000048]In the Box
The box contains the following items:
· BI X Series braille display
· USB-C to USB-A cable
· USB to AC adapter
· Carrying case with lanyard
· Print Getting Started guides
· Braille insert on how to access user guide
1.2. [bookmark: _Toc209000049]Orientation of BI X Series
The BI X series has a 20-cells or a 40-cells braille display, a Perkins-style keyboard, two Space bars, a Home button and four thumb keys for navigation. The BI 40X also has three command keys either side of the braille display (six in total).
1.2.1. [bookmark: _Toc209000050]Top Face
The top face of the BI X Series can be divided into two sections: front and rear.
The front section of the top face of the BI X Series consists of a refreshable braille display containing 20 or 40 braille cells and 20 or 40 cursor routing buttons, and two space bars. Each cursor routing button is associated with the braille cell directly below it. When editing text, pressing one of the cursor routing buttons moves the editing cursor to the associated braille cell. While in the menus, pressing any cursor button activates the selected item. 
When you are not editing text, any cursor button activates a selected item. 
On the BI 40x only, there are six command keys that can be found on either side of the Braille display, three to the left and three to the right. On the left, starting from the back, are C1, C2 and C3, which is the one nearest you. On the right side, you will find C4, C5 and C6 nearest you. 
The rear section of the top face includes a Perkins-style braille keyboard where each key represents a Dot on a braille cell. The keys under your left hand represent Dots 1, 2, 3, and Backspace, where Dot 1 is located under your index finger and Backspace under your little finger. The keys under your right hand represent Dots 4, 5, 6, and Enter, where Dot 4 is located under your index finger and Enter under your little finger. There is a speaker, on the right edge, on the BI 20X and two speakers (one on each side) on the BI 40X, for stereo sound. On the BI 40X, you can also find an integrated microphone next to the right speaker (Note the microphone is not active).
The Braille keyboard and command keys can be used to type Braille or perform commands. The commands depend on the screen reader used.
1.2.2. [bookmark: _Toc209000051]Front Edge
On the front edge of the BI X Series are five buttons. From left to right, the buttons are as follows:
· Previous thumb key
· Left thumb key 
· Home button (circular shape) – used to return to the Main menu, exit Terminal mode or access to the settings when in Terminal mode only (see section 7.6 “Terminal only mode”).
· Right thumb key
· Next thumb key
1.2.3. [bookmark: _Toc209000052]Left Edge
On the left edge, from front to back are the following:
· USB-A port 
· Power button – press and hold this button for 2 seconds to turn the device ON. 
· Green LED – visually indicates the status of the device
· USB-C port – use the cable that came with your BI X Series to connect it to a power outlet or a PC.
1.2.4. [bookmark: _Toc209000053]Right Edge
On the right edge, from front to back are the following:
· Two volume buttons 
· 3.5mm Audio jack
1.2.5. [bookmark: _Toc169270687][bookmark: _Toc209000054]Rear Edge (BI 20X only)
The rear edge only contains an SD card port located near the left edge of the device. This port allows you to insert SD cards for external storage. 
1.2.6. [bookmark: _Toc209000055]Bottom Side
Underneath your BI 40X are two large sections of anti-slip rubber pads, one on each side. 
In the middle, closer to the front edge is a slightly indented rectangle with a different texture. In this rectangle is a sticker containing printed hardware information about your BI 40X. Above the sticker, there is a braille label containing the serial number of your device.
On the BI 20X, in each corner underneath your device are four anti-slip pads. 
In the middle, closer to the front edge is a slightly indented rectangle with a different texture. In this rectangle is a sticker containing printed hardware information about your device. Above the sticker, there is a braille label containing the serial number of your device.
Towards the back left of the device is the battery compartment. It is closed and secured with two Phillips-head screws. 
1.3. [bookmark: _Toc209000056]Charging your device
Prior to using your device, make sure it is charged completely. 
Connect the USB-C end of the recharge cable to the USB-C port located on the left edge of your Bi X Series. Minimal effort is required and forcing the connection can damage the cable or the device. 
Connect the USB-A end of the recharge cable to the power adapter, then plug the power adapter into a power outlet. Use the provided power adapter for optimal recharge.
Alternatively, you can charge the device using your computer and the USB-A to USB-C recharge cable, but note that this method of charging is slower than charging with a power adapter.
1.4. [bookmark: _Toc209000057]Powering On and Off
The Power button is on the left edge of the BI X Series; it is oval-shaped. 
If your device is charged, press and hold the Power button for approximately 2 seconds to power on the device. There is a quick vibration and “starting” appears on the braille display along with a tactile loading animation that circles during start-up. 
A few moments after you boot your device for the first time, you will be welcomed with a language selection menu. Press Enter to open the list of languages, select one and press Enter to close the list. The options of the menu will be spoken via a text-to-speech feature using the default primary selected voice. Please note that only selected languages are installed by default. Upon connecting to Wi-Fi, you will be prompted to install your selected text-to-speech voice depending on your system language.
Another item available is “Start in terminal”. If you prefer the BI X Series to startup in terminal mode each time from a complete shutdown, you can activate this by pressing Enter. Refer to the user settings section for more information on activating or deactivating the start up in terminal. It is also possible to use the device in Terminal-only mode (please refer to section 7.6 “Terminal-only mode” to know more).
Close the dialog box once the changes are completed.
After a few seconds, the start-up is complete and “terminal” appears on the braille display. Your BI X Series is now ready for use. 
If however you turned on start in terminal, the BI X Series will prompt “USB connection”. 
To power Off, press and hold the Power button for approximately 2 seconds. A confirmation message appears on the braille display. Select Ok by pressing the Previous or Next thumb key, then press Enter or a Cursor-routing key.
Alternatively, you can follow these steps to power Off the BI X Series:
· Press P to reach the Power Off menu item.
· Press Enter or a cursor routing key.
· Select Ok by pressing the Previous or Next thumb key.
· Press Enter or a cursor routing key.
1.5. [bookmark: _Toc209000058]Adjusting the Sleep Mode and auto power off
1.5.1. [bookmark: _Toc209000059]Adjusting the Sleep mode 
To preserve the battery, BI X Series goes into Sleep mode after 5 minutes of inactivity. You can adjust the length of time in the User settings. You can also manually put your device into Sleep mode by a short press of the Power button.
If the device is in the sleep status, to wake up the device, short press the Power button.
1.5.2. [bookmark: _Toc209000060]Adjusting the auto power off
Auto power off will automatically power off your device after a designated period of inactivity.  By default, your device will shutdown automatically after 3 hours of inactivity to preserve the battery life of your device. You can modify this setting in the user settings, under the “Auto power off subsection”. Here, you will have the opportunity to set the auto power off after 1 hour, 2 hours, 3 hours (by default), 4 hours or never if you don’t want your device to auto power off. 
When the auto power off time is reached, a message asking if you want to shutdown will be displayed. If you don’t react during the next minute, the device will automatically shut down. If your device has been shutdown automatically, press and hold the Power button for 2 seconds to restart your device. 
1.6. [bookmark: _Toc209000061]About the About Menu
The About menu provides various information about your device, such as version numbers, model number, serial number, licenses, and copyright.
To open the About Menu:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Go to the About item.
· Press Enter. 
Alternatively, you can use the shortcut Space + I to open the About dialog. 
1.7. [bookmark: _Toc209000062]Launching the Main Menu
The KeySoft Main menu is your device’s default home menu. From the main menu, you can access all KeySoft Lite applications. When you start your BI X Series or close an application, you automatically return to this menu.
You can at any time return to the main menu by simply pressing the Home button on your device (the button shaped like a circle located on the front edge of your BI X Series, in the middle). Alternatively, you can use the Go to Main Menu command on the keyboard by pressing SPACE + DOTS 1 2 3 4 5 6.
2. [bookmark: _Toc209000063]Navigating and Using Menus
KeySoft Lite is the heart of your BI X Series, supporting all applications that are built in your braille display. KeySoft’s main menu can also be customized, which will allow you to hide and unhide applications from the Main menu. More information on customizing your Main Menu can be found in the Customize KeySoft’s Main Menu section.
2.1. [bookmark: _Toc209000064]Navigating the Main Menu
The Main menu contains the following items:
· Terminal
· Editor: KeyPad
· Braille editor : KeyBrf
· Recorder: KeyRecorder (BI 40X only)
· Victor Reader
· File manager : keyFiles
· Calculator : keyCalc
· Date and time
· Options
· Online services
· User guide
· Power Off
Press the Previous or Next thumb keys to scroll through the list to the menu item of your choice. Then press Enter or a cursor routing key to access it.
You can return to the Main menu at any time by pressing the Home button or Space with all six Dots.
2.2. [bookmark: _Toc209000065]Panning Text on the Braille Display
Often times the text on the braille display is too long to fit on a single line. To read the entire sentence, scroll or “pan” the text ahead or back by pressing the Left and Right thumb keys on the device. The Left and Right thumb keys are the second and third buttons on the front edge	of the device. 
2.3. [bookmark: _Toc209000066]Using the Context Menu for Additional Functions
The Context Menu lists all available actions for the KeySoft application you are currently working on as well as their associated commands. It can be very useful when you forget how to carry out a specific command. 
To activate the Context Menu, press Space + M. A menu opens with a list of actions you can perform at that particular moment. Scroll through the menu to the desired action and press Enter or a cursor routing key. 
Press Space + E to exit the Context Menu.
2.4. [bookmark: _Toc209000067]Navigating by First Letters of Words
Most of the time, you can jump to an item in a menu by typing the first letter of that item. Doing so automatically moves your focus to the first item in the list starting with that letter. Typing the same letter twice moves the focus to the second item in the list starting with that letter, and so on. 
For example, to reach the Options menu on the BI X Series, you type the letter ‘O’ on your keyboard.
Note that KeySoft apps found on your main menu are optimized for first letter navigation.
It is also possible to easily switch between applications without the need to return to the main menu. Providing you know the first letter of the application you want to open, press the letter combined with Enter and Backspace. 
For example, to open the Editor: KeyPad application, type the letter ‘E’ with Enter + Backspace.
2.5. [bookmark: _Toc209000068]Using Shortcuts/Key Combinations to Navigate
As the name implies, shortcuts, also known as key combinations, make it easy to quickly navigate through a menu or file. 
The most commonly used shortcuts on the BI X Series are indicated in Table 1.
Table 1: Shortcut/Key Combination Table
	Action
	Shortcut or Key Combination

	Activate Selected item
	Enter or cursor routing key

	Escape or Back
	Space + E

	Previous item
	Previous thumb key, C1 or Space + Dot 1

	Next item
	Next thumb key, C3 or Space + Dot 4

	Jump to any item in a list
	Type the first letter of the item or app

	Pan left and right
	Left or Right thumb key or C2 (pan left) and C5 (pan right)

	Go to top
	Space + Dots 1-2-3

	Go to bottom
	Space + Dots 4-5-6

	Toggle Braille grade
	Backspace + G

	Switch language profile
	Enter + L or C4 

	Battery level
	Enter + P

	Context menu
	Space + M

	Main menu
	Space + Dots 1-2-3-4-5-6 or Home button

	System information
	Space + I

	Time
	Enter + T

	Date
	Enter + D

	Eject media
	Enter + E

	Options
	Space + O

	Create a quick note
	Backspace + N

	Create a quick braille note
	Backspace + B

	Toggle speech on/off
	Space + Previous Thumb Key

	Increase speech rate
	Enter + Dot 5

	Decrease speech rate
	Enter + Dot 2

	Open Terminal
	Backspace + Enter + T

	Open KeyPad
	Backspace + Enter + E

	Open KeyRecorder
	Backspace + Enter + R

	Record note
	Enter + N

	Stop recording
	Enter + X

	Pause/Resume recording
	Backspace + Enter

	Cancel recording
	Space + E

	Open Victor Reader
	Backspace + Enter + V

	Open KeyFiles 
	Backspace + Enter + F

	Open KeyCalc
	Backspace + Enter + C

	Open Bookshare
	Backspace + Enter + B

	Open NFB Newsline
	Backspace + Enter + W

	Open NLS Bard
	Backspace + Enter + N

	Search for WI-FI
	Backspace + Enter + S

	Help
	Space + H

	List all the paired audio devices
	Enter + Backspace + A


Note: All commands that include Enter or Backspace must have the Space Bar added to them when using computer braille.
3. [bookmark: _Toc209000069]Connectivity
3.1. [bookmark: _Toc209000070]Connecting your BI X Series to a Wi-Fi network
BI X Series can be connected to a Wi-Fi network. It can be very useful to download voices, books and magazines from online providers, and it is mandatory to access some apps (for example, Wikipedia and Wiktionary).
To access the Wi-Fi settings, when on the Main menu, press the shortcut Space + O. Then, in the list that is displayed, navigate with the Previous and Next thumb keys until attaining the Wi-Fi option, then press Enter or any cursor-routing key to enter in this menu. 
· Activate and deactivate Wi-Fi: The first item of the Wi-Fi menu is labelled Wi-Fi. If it is enabled, it will be indicated “on”. Click on this option with the cursor-routing keys and it will deactivate the Wi-Fi capability. Click again on this option with the cursor-routing keys to reactivate it.
· Status: In this subsection, you will find the SSID (the name of the Wi-Fi network in which you are connected if any), the signal strength, the IP address and the Mac address. On BI 40X, you will also find the Wi-Fi frequency, as this device can connect to 2.4 and 5 GHz networks. BI 20X can only connect to 2.4 GHz networks.
· New Connection: In this subsection, you can search for new connections. The device can scan for SSID (it will list all the available networks in your vicinity), it can establish a WPS connection (by using the WPS option on your router) and it can manually connect (by allowing you to enter the information about the network to which you want to connect). When selecting a network in the list, you will have to enter the password associated to this specific network, then press Enter to validate the connection. If the password is accurate and the connection successful, you will be informed and the connection will be established. If it fails, an error message will be displayed and you will be prompted to enter the password again.
· Launch connection: In this list, you will see the networks with which you connected your device before. Press Enter or any cursor-routing key on one of them to establish the connection.
· Delete connection: In this list, all the networks with which you connected the device before will be displayed. Press Enter or any cursor-routing key on the network that you want to delete, and the network will be deleted.
· Network settings: It allows to modify some technical settings about the network to which you are connected, for example, the DHCP.
· Import Wi-Fi configuration: You can import a Wi-Fi configuration from another device. To perform this operation, you will have to connect a USB thumb drive or an SD card (BI 20X only) to your device.
· Validate connection: this option allows to test the connection with which your device is connected, to validate that it works properly. You will be informed of the success or failure of this procedure.
3.2. [bookmark: _Toc209000071]Connecting BI X Series to a Bluetooth device
BI X Series can be used with Bluetooth devices. Some of them can be accessed via the Terminal (see section 7.1.4 to know how to connect Bluetooth devices to your Terminal). For audio devices, you have to use the Bluetooth settings. To access to these settings, press Space + O to go to the Settings, then navigate with the Previous and Next thumb keys until attaining the Bluetooth option.
· Activate or deactivate Bluetooth: the first option allows to activate or deactivate Bluetooth. If Bluetooth is set to on, Bluetooth devices can be connected to the device. Press on any cursor-routing key to put this option at Off and to prevent any Bluetooth connection. Press again on any cursor-routing key to reactivate it.
· Pair audio device: press on the Enter key or on any cursor-routing key to activate this option. BI X Series will scan the environment to find audio Bluetooth devices to connect. In order to perform the connection, the audio device has to be in pairing mode. If BI X Series identifies the device, it will be listed. Press on the enter key or any cursor-routing key to connect to this device.
· Connect device: this option lists all the Bluetooth devices configured in your device. You can select one of them, to which you are not connected at that time, to connect to your BI X Series. Press Enter or any cursor-routing key on the desired device and if the device is powered on and near the BI X Series, it will connect.
· Disconnect device: it allows to disconnect to any Bluetooth device with which you are currently connected to your BI X series. When you are positioned on the device you want to disconnect, press the Enter key or any cursor-routing key to disconnect.
· Delete paired device: in this list of previously paired devices to the BI X Series, you will be able to delete one of them. When positioned on the device you want to delete, press Enter or any cursor-routing key. A confirmation message will be prompted, then the device will be disconnected after you will have pressed Enter or any cursor-routing key to validate this message and confirm the action.
3.2.1. [bookmark: _Toc209000072]Bluetooth audio devices menu
This menu offers a quick access to Bluetooth audio devices and their settings. To access to this menu, use the shortcut Backspace + Enter + A. If no audio Bluetooth device had been configured, a message will be displayed giving this information and you will stay at your current position. If an audio Bluetooth device had been configured, it will be displayed when entering in this menu. An 8-dot symbol is added at the end of the device’s name if it is connected. By entering in the Context menu with the shortcut Space + M on the device’s name, you will have the option to connect device (that will try to connect the device if it was not connected before and that will reconnect the device if it is already connected), disconnect device and delete paired device. Please note that when your cursor is positioned on a device, you can press Enter to connect it directly. In the Bluetooth audio devices menu, after the list of previously connected audio devices, you will find a Close button to leave this menu.

4. [bookmark: _Toc209000073] Using the KeyPad Application
KeyPad is an application that allows you to open, edit, and create text files on the Bi X Series. You can open .docx, .doc, .odt, .txt, .brf, .brl, .pdf, .ban, and .bra files with KeyPad. The files you create or modify are saved as a .txt file.
To open KeyPad, press the Next thumb key until you reach Editor: KeyPad or press ‘e’ in the Main menu, then press Enter or a cursor routing key.
KeyPad opens a sub menu, which includes Create file, Open file, Recently Saved, Editor settings, and Close.
4.1. [bookmark: _Toc209000074]Create a File
There are several ways to create a file depending on your current location on the device. 
· If you are in the KeyPad menu, select Create file and press Enter or a cursor routing key.
· From the Context menu, select and activate File menu, then Create file. 
· Alternatively, press Backspace + N from anywhere on the device to quickly create a new file.
The cursor is visible between two braille brackets, and can be set as blinking in the User Settings. You can begin writing in your new file. 
4.2. [bookmark: _Toc209000075]Open a File
If you are in the KeyPad menu, select Open file and press Enter or a cursor routing key. Alternatively, you can press Backspace + O, then select the file you wish to open using the Previous and Next thumb keys.
Note that the BI X Series can display an error message when a PDF file is opened. This generally occurs when the file contains images rather than text.
4.3. [bookmark: _Toc209000076]Recently Saved
You can open a list of the last ten documents you previously saved for quick access.
To open a list of the ten most recent files, select the KeyPad application from the main menu. Use your Previous or Next thumb keys until you reach recently saved and press Enter.
You can scroll through the ten most recent files using the Previous and Next thumb keys. Press Enter or a cursor-routing key to open a file from the list.
4.4. [bookmark: _Toc209000077]Close a File
To close a file that is opened in KeyPad, press Space + E. Alternatively, open the Context menu using Space + M, then scroll to and activate the File menu. Select Close file item.
If there are changes to your file that have not been saved, you are asked if you want to save the changes before closing.
Note: If your device shuts down before you have saved your document, when you will restart your device and return to Keypad, a message will be prompted indicating that the file was not closed properly and asking you if you want to open or to discard the file.
4.5. [bookmark: _Toc209000078]Save a Text File
There are two types of saving in KeyPad: Save and Save as.
· Save: Press Space + S to save your file to an already existing filename.
· Save as: Press Backspace + S to save a copy of your file with a new filename and change the location.
If your file has never been saved, KeyPad asks you to enter a new file name regardless of the save method you choose.
Note that if you open a file under any extension other than .txt, the device will prompt a message asking if you wish to keep the original file in addition to the .txt file that will be saved.
4.6. [bookmark: _Toc209000079]Auto Scrolling Through Written Text in the KeyPad
The KeyPad app features an Auto Scroll functionality that automatically pans through the written text on the braille display. 
To start Auto Scrolling, press Enter + Dots 1-2-4-5-6 or C6. 
To stop Auto Scrolling, press any key.
4.6.1. [bookmark: _Toc209000080]Modifying Auto Scroll Speed
You can change the Auto Scroll speed when auto-scrolling inside a file. 
To slow down Auto Scroll, press Enter + Dot 3.
To speed up Auto Scroll, press Enter + Dot 6.
4.7. [bookmark: _Toc209000081]Finding Text in a File
To find text in your file, press Space + F. Enter your search term in the blank field. Your cursor is placed at the first location the text is found. 
Press Space + N to find additional instances of the search word. 
Press Space + P to reach previous instances of the search word.
4.7.1. [bookmark: _Toc209000082]Finding and Replacing Text
To find and replace text: 
· Press Backspace + F. 
· Enter the text to find in the first edit box.
· Enter the text to replace it within the second prompted edit box.
· Press the Next button to find the next instance of the word. 
· Press the Next button to find Replace All. 
4.8. [bookmark: _Toc209000083][bookmark: _Hlk179365696]Cutting, Copying, and Pasting Text
KeyPad lets you cut, copy, and paste text in a way similar to computer programs. 
To select the text, position your cursor on the first character using a cursor routing button, then press Enter + S. 
Alternatively, you can select text from the Context menu:
· Open the Context menu with Space + M. 
· Scroll down to Edit.
· Press Enter or a cursor routing key. 
· Scroll down to Select Text. 
· Press Enter or a cursor routing key.
This marks the start of your selection. Now go to the location at the end of your selection, and press Enter + S to end the selection.
To select All text included in the file, press Enter + Dots 1-2-3-4-5-6.
To copy the selected text, press Backspace + Y.
To cut the selected text, press Backspace + X.
To paste the copied or cut text, position your cursor where you want the text to be pasted using a cursor routing button and press Backspace + V.
As always, these commands can be accessed through the Context menu.
The Backspace + Y shortcut can also be used to copy the last result from the KeyCalc application and the current paragraph from the Victor Reader application.
4.9. [bookmark: _Toc209000084]Search on Wikipedia, on Wiktionary and in WordNet
With Keypad, it is possible to obtain more information about a specific word by performing a search on Wikipedia, on Wiktionary or in WordNet. These 3 modules can be accessed via the Context menu, under the Edit submenu, or you can press the following shortcuts:
· Search on Wikipedia: Enter + W
· Search on Wiktionary: Enter + Dots 2-5-6
· Search in WordNet: Space + D
Note: You can obtain more information about these modules in the section 11 “Modules available in multiple applications”.
4.10. [bookmark: _Toc209000085]Using the Read Mode
Read mode allows you to read files without the possibility of editing content by mistake. You cannot edit files while in Read mode. 
To activate or deactivate Read mode, press Space + X.
To activate or deactivate Read mode from the Context menu:
· Press Space + M to activate the Context menu.
· Scroll to File using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Scroll to Read mode using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
4.11. [bookmark: _Toc209000086]Inserting Date and Time
When creating a file in the KeyPad application, you have the option to insert the current date and time in the file. 
To insert date and time:
· Press Space + M to activate the Context menu.
· Scroll to Edit using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Scroll to Insert using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Scroll to Insert date or Insert time using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
4.12. [bookmark: _Toc209000087]Adding, Navigating, and Removing Bookmarks
Bookmarks are a useful way to keep your location within a file and allow you to return quickly to that position at a later time. 
To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
4.12.1. [bookmark: _Toc209000088]Inserting a Bookmark
To add a bookmark in a file:
· Press Enter + M to open the Bookmark menu. 
· Select Insert Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number. 
· Note: If you do not enter a number, BI X Series selects the first available number and assigns it to the bookmark.
· Press Enter. 
Alternatively, you can insert a Bookmark by pressing Enter + B. Note that a maximum of 98 bookmarks can be inserted in a KeyPad document.
4.12.2. [bookmark: _Toc209000089]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
4.12.3. [bookmark: _Toc76540406][bookmark: _Toc146185331][bookmark: _Toc209000090]Removing Bookmarks
To remove a saved Bookmark:
· Press Enter + M to open the Bookmark menu. 
· Scroll to Remove Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter the Bookmark number you want to remove.
· Press Enter.
Note: If you want to remove all bookmarks in the document type 99999 when prompted Bookmark number.
4.13. [bookmark: _Toc209000091]Toggle text indicators
Text indicators are a useful tool to help you locate your position when working in document of the Editor. Upon activating the text indicators, brackets will appear on the braille display to indicate the beginning and the ending of the text.
To toggle text indicators:
· Press Space + M to activate the Context menu.
· Use the Previous or Next thumb keys until you reach File Menu and press Enter.
· Use the Previous or Next thumb keys until you read editor settings and press Enter.
· Use the Previous or Next thumb keys until you reach show text editor indicators.
· Press Enter to deactivate the Text indicators; press Enter again to activate them.
Note that toggling Text Indicators will only apply to the editor; all other edit fields will continue to include text indicators.
4.14. [bookmark: _KeyPad_Commands_Table][bookmark: _Toc209000092]KeyPad Commands Table
The KeyPad commands are listed in Table 2.
Table 2: KeyPad Commands
	Action
	Shortcut or Key Combination

	Activate edit mode
	Enter or a cursor routing key

	Leave edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/Stop selection
	Enter + S

	Select all 
	Enter + Dots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Enter + Dots 1-2-4-5-6 or C6

	Increase auto-scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + Dots 2-5-6

	Search in WordNet
	Space + D

	Read all (text-to-speech feature)
	Space + G

	Stop reading (text-to-speech feature)
	Backspace + Enter

	Toggle Reading mode 
	Space + X

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B


5. [bookmark: _Toc209000093]Using the KeyBrf Application 
KeyBrf is an application similar to KeyPad, but explicitly designed to edit, open and create braille documents in .brf and .brl format. The files are created, modified, and saved as .brf.
To open KeyBrf, press the Next thumb key until you reach the item Braille Editor: KeyBrf or press “B” in the Main menu, then press Enter or a cursor-routing key.
KeyBrf opens with the Braille Editor menu, which includes Create File, Open File, Recently Saved, Braille Editor Settings, and Close.
Note that the Text-to-speech (TTS) feature is not possible with the Braille Editor application.
5.1. [bookmark: _Toc209000094]Create a file
There are several ways to create a file, depending on your current location on the device. 
· If you are in the Braille Editor menu, select Create File and press Enter or a cursor-routing key.
· From the Context menu, select and activate the File menu, then select Create File. 
· Alternatively, press Backspace + B from anywhere on the device to quickly create a new .brf file.
The cursor will be visible between two braille brackets and can be set as blinking in the User settings. You can begin writing in your new file.
Please note: as BRF documents are written in 6-dots Braille, pressing the dots 7 or 8 while writing your Braille document will display an error message. 
5.2. [bookmark: _Toc209000095]Open a file
If you are in the Braille Editor menu, select Open File and press Enter or a cursor-routing key. Alternatively, you can press Backspace + O, then select the file you wish to open using the Previous and Next thumb keys.  
5.3. [bookmark: _Toc209000096]Recently saved
You can open a list of the last ten documents you previously saved for quick access.
To open a list of the ten most recent files, select the KeyBrf application from the main menu. Use your Previous or Next thumb keys until you reach recently saved and press Enter.
You can scroll through the ten most recent files using the Previous and Next thumb keys. Press Enter or a cursor-routing key to open a book from the list.
5.4. [bookmark: _Toc209000097]Close a file
To close a file that is opened in the Braille Editor, press Space + E. Alternatively, open the Context menu using Space + M, then scroll to and activate the File menu. Select Close File Item.
If there are changes to your file that have not been saved, you will be asked if you want to save the changes before closing.
Note: If your device shuts down before you have saved your document, when you will restart your device and return to KeyBRF, a message will be prompted indicating that the file was not closed properly and asking you if you want to open or to discard the file. 
5.5. [bookmark: _Toc209000098]Save a Braille file
There are two types of saving in KeyBrf: Save and Save as.
· Save: Press Space + S to save your file to an already existing file name.
· Save as: Press Backspace + S to save a copy of your file with a new file name and to change the file location.
If your file has never been saved, KeyBrf will ask you to enter a new file name regardless of the save method you choose.
5.6. [bookmark: _Toc209000099]Export a Braille file to Text
The .brf files opened in the Braille Editor application can be exported as text files. This can be useful if you wish to open them in the Editor application and work on them in another format.
To export a braille file to text:
· Press Space + M to open the Context menu. 
· Using the Previous and Next thumb keys, navigate until reaching the “Edition” item then press on Enter or any cursor-routing key to select it.
· Use the Previous and Next thumb keys to select the option Export as text and press Enter.
· The BI X Series will display a list of braille tables for exportation. Use the Previous and Next thumb keys to select the braille table of your choice and press Enter. 
· You will be prompted to enter a name for the exported file. Type the desired name and press Enter.
· You will be prompted with the list of KeyFiles folders in which you can save your newly created file. Select the folder of your choice using the Previous and Next thumb keys and press Enter.
5.7. [bookmark: _Toc209000100]Using Auto-Scroll in KeyBRF
The KeyBrf app includes an Auto-Scroll feature that automatically pans through the written text on the braille display. 
To start Auto-Scroll, press Enter + Dots 1-2-4-5-6. 
To stop Auto-Scroll, press any key.
5.7.1. [bookmark: _Toc209000101]Modifying Auto-Scroll Speed
You can change the Auto-Scroll speed when auto-scrolling inside a file. 
To slow down Auto-Scroll, press Enter + Dot 3.
To speed up Auto-Scroll, press Enter + Dot 6.
5.8. [bookmark: _Toc209000102]Finding text in a file
To find text in your file, press Space + F. Enter your search term in the blank field. Your cursor will be placed at the first location the text is found. 
Press Space + N to find additional instances of the search word. 
Press Space + P to reach previous instances of the search word.
5.8.1. [bookmark: _Toc144883531][bookmark: _Toc144895181][bookmark: _Toc144895332][bookmark: _Toc144895618][bookmark: _Toc144895852][bookmark: _Toc144970012][bookmark: _Toc144993534][bookmark: _Toc145058432][bookmark: _Toc145589179][bookmark: _Toc145657396][bookmark: _Toc145657552][bookmark: _Toc145663056][bookmark: _Toc145926158][bookmark: _Toc145926313][bookmark: _Toc145926468][bookmark: _Toc145926623][bookmark: _Toc145926778][bookmark: _Toc145926933][bookmark: _Toc146102201][bookmark: _Toc146102375][bookmark: _Toc146102538][bookmark: _Toc146103108][bookmark: _Toc146105286][bookmark: _Toc146106352][bookmark: _Toc146106517][bookmark: _Toc146106673][bookmark: _Toc146108358][bookmark: _Toc146118469][bookmark: _Toc146118623][bookmark: _Toc146119265][bookmark: _Toc146122934][bookmark: _Toc146637783][bookmark: _Toc146637998][bookmark: _Toc146638150][bookmark: _Toc209000103]Finding and replacing text
To find and replace text: 
· Press Backspace + F. 
· Enter the text to find in the first edit box, called Find.
· Enter the replacement text in the second edit box, called Replace.
· Select Replace All to replace all text found with the text in the Replace box. 
· Select Next to find and replace the next instance of the word.
· Select Previous to find and replace the previous instance of the word.
5.9. [bookmark: _Toc209000104]Cutting, copying, and pasting text in a file
KeyBrf lets you cut, copy, and paste text in a way similar to computer programs. 
To select the text, position your cursor on the first character using a cursor-routing key, then press Enter + S. 
Alternatively, you can select text from the Context menu:
· Open the Context menu with Space + M. 
· Scroll down to Edit.
· Press Enter or a cursor-routing key. 
· Scroll down to Select Text. 
· Press Enter or a cursor-routing key.
This marks the start of your selection. Now go to the location at the end of your selection, and press Space + S to end the selection.
To select all text included in the file, press Enter + Dots 1-2-3-4-5-6.
To copy the selected text, press Backspace + Y.
To cut the selected text, press Backspace + X.
To paste the copied or cut text, position your cursor where you want the text to be pasted using a cursor-routing key and press Backspace + V.
As always, these commands can be accessed through the Context menu.
The Backspace + Y shortcut can also be used to copy the last result from the KeyCalc application and the current paragraph in the Victor Reader application.
5.10. [bookmark: _Toc209000105]Search on Wikipedia, on Wiktionary and in WordNet
With KeyBRF, it is possible to obtain more information about a specific word by performing a search on Wikipedia, on Wiktionary or in WordNet. These 3 modules can be accessed via the Context menu, under the Edit submenu, or you can press the following shortcuts:
· Search on Wikipedia: Enter + W
· Search on Wiktionary: Enter + Dots 2-5-6
· Search in WordNet: Space + D
Note: You can obtain more information about these modules in the section 11 “Modules available in multiple applications”.

5.11. [bookmark: _Toc146725604][bookmark: _Toc159326988][bookmark: _Toc159500274][bookmark: _Toc146725605][bookmark: _Toc159326989][bookmark: _Toc146725606][bookmark: _Toc159326990][bookmark: _Toc159500275][bookmark: _Toc209000106]Using Read mode
Read mode allows you to read files without the possibility of editing content by mistake. You cannot edit files while in Read mode. 
To activate or deactivate Read mode, press Space + X.
To activate or deactivate Read mode from the Context menu:
· Press Space + M to activate the Context menu.
· Scroll to File using the Previous and Next thumb keys.
· Press Enter or a cursor-routing key.
· Scroll to Read mode using the Previous and Next thumb keys.
· Press Enter or a cursor-routing key.
5.12. [bookmark: _Toc209000107]Adding, navigating and removing bookmarks
Bookmarks are a useful way to keep your location within a file and allow you to return quickly to that position at a later time. 
To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
5.12.1. [bookmark: _Toc144883536][bookmark: _Toc144895186][bookmark: _Toc144895337][bookmark: _Toc144895623][bookmark: _Toc144895857][bookmark: _Toc144970017][bookmark: _Toc144993539][bookmark: _Toc145058437][bookmark: _Toc145589184][bookmark: _Toc145657401][bookmark: _Toc145657557][bookmark: _Toc145663061][bookmark: _Toc145926163][bookmark: _Toc145926318][bookmark: _Toc145926473][bookmark: _Toc145926628][bookmark: _Toc145926783][bookmark: _Toc145926938][bookmark: _Toc146102206][bookmark: _Toc146102380][bookmark: _Toc146102543][bookmark: _Toc146103113][bookmark: _Toc146105291][bookmark: _Toc146106357][bookmark: _Toc146106522][bookmark: _Toc146106678][bookmark: _Toc146108363][bookmark: _Toc146118474][bookmark: _Toc146118628][bookmark: _Toc146119270][bookmark: _Toc146122939][bookmark: _Toc146637788][bookmark: _Toc146638003][bookmark: _Toc146638155][bookmark: _Toc146725609][bookmark: _Toc159326993][bookmark: _Toc144883537][bookmark: _Toc144895187][bookmark: _Toc144895338][bookmark: _Toc144895624][bookmark: _Toc144895858][bookmark: _Toc144970018][bookmark: _Toc144993540][bookmark: _Toc145058438][bookmark: _Toc145589185][bookmark: _Toc145657402][bookmark: _Toc145657558][bookmark: _Toc145663062][bookmark: _Toc145926164][bookmark: _Toc145926319][bookmark: _Toc145926474][bookmark: _Toc145926629][bookmark: _Toc145926784][bookmark: _Toc145926939][bookmark: _Toc146102207][bookmark: _Toc146102381][bookmark: _Toc146102544][bookmark: _Toc146103114][bookmark: _Toc146105292][bookmark: _Toc146106358][bookmark: _Toc146106523][bookmark: _Toc146106679][bookmark: _Toc146108364][bookmark: _Toc146118475][bookmark: _Toc146118629][bookmark: _Toc146119271][bookmark: _Toc146122940][bookmark: _Toc146637789][bookmark: _Toc146638004][bookmark: _Toc146638156][bookmark: _Toc146725610][bookmark: _Toc159326994][bookmark: _Toc144883538][bookmark: _Toc144895188][bookmark: _Toc144895339][bookmark: _Toc144895625][bookmark: _Toc144895859][bookmark: _Toc144970019][bookmark: _Toc144993541][bookmark: _Toc145058439][bookmark: _Toc145589186][bookmark: _Toc145657403][bookmark: _Toc145657559][bookmark: _Toc145663063][bookmark: _Toc145926165][bookmark: _Toc145926320][bookmark: _Toc145926475][bookmark: _Toc145926630][bookmark: _Toc145926785][bookmark: _Toc145926940][bookmark: _Toc146102208][bookmark: _Toc146102382][bookmark: _Toc146102545][bookmark: _Toc146103115][bookmark: _Toc146105293][bookmark: _Toc146106359][bookmark: _Toc146106524][bookmark: _Toc146106680][bookmark: _Toc146108365][bookmark: _Toc146118476][bookmark: _Toc146118630][bookmark: _Toc146119272][bookmark: _Toc146122941][bookmark: _Toc146637790][bookmark: _Toc146638005][bookmark: _Toc146638157][bookmark: _Toc146725611][bookmark: _Toc159326995][bookmark: _Toc159500278][bookmark: _Toc159500279][bookmark: _Toc159500280][bookmark: _Toc209000108]Inserting a bookmark
To add a bookmark in a file:
· Press Enter + M to open the Bookmark menu. 
· Select Insert Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number. 
· Note: If you do not enter a number, the BI X Series selects the first available number and assigns it to the bookmark.
· Press Enter. 
Alternatively, you can insert a Bookmark by pressing Enter + B. Note that a maximum of 98 bookmarks can be inserted in a document.
5.12.2. [bookmark: _Toc209000109]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
5.12.3. [bookmark: _Toc209000110]Removing Bookmarks
To remove a saved Bookmark:
· Press Enter + M to open the Bookmark menu. 
· Scroll to Remove Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter the Bookmark number you want to remove.
· Press Enter.
Note: If you want to remove all bookmarks in the document type 99999 when prompted Bookmark number.
5.13. [bookmark: _Toc209000111]Toggle text indicators
Text indicators are a useful tool to help you locate your position when working in document of the Braille Editor. Upon activating the text indicators, brackets will appear on the braille display to indicate the beginning and the ending of the text.
To toggle text indicators:
· Press Space + M to activate the Context menu.
· Use the Previous or Next thumb keys until you reach file menu and press Enter.
· Use the Previous or Next thumb keys until you reach editor settings and press Enter. 
· Use the Previous or Next thumb keys until you reach show text editor indicator. 
· Press Enter to deactivate the Text indicators; press Enter again to activate them.
Note that the toggling Text Indicators will only apply to the Braille editor, all other edit fields will continue to include text indicators.
5.14. [bookmark: _Toc209000112]Format BRF
KeyBRF offers Braille formatting options. It can be very useful to format your Braille documents the way they will be printed in Braille. 
To adjust the Braille formatting of your documents, go to the KeyBRF application. Then, in the menu, press Enter on the Editor settings. In this window, you will find the option “Format BRF”. Press Enter to activate this option; press Enter again to deactivate it. If you continue to navigate in that window, you will be able to select the number of characters per line to display, and the number of lines per page. These two controls can be modified to display exactly the number of characters per line and the number of lines per page that you want in your Braille document when you will print it. To modify one of these controls, press Enter on the desired one, then change the default value indicated, then press Enter to confirm your choice.
When on a BRF document, if the “Format BRF” option is activated, two options are added to the Contextual menu, in the File menu. You can be informed of your exact position in your document depending on the Braille formatting options chosen; this is the Where Am I function. To obtain this information, you can also press the shortcut Space + Dots 1-5-6. You can also access to a preview of your document when printed in braille. To access to the preview mode, you can also use the shortcut Enter + V.
Note: even though you deactivate the option “Format markers” in the Keysoft’s User settings menu, they will be rendered when your document will be in Preview mode.
5.14.1. [bookmark: _Toc209000113]Preview mode
When the “Format BRF” option is enabled, you will have the opportunity to read your document in preview mode, by using the shortcut Enter + V or by selecting this option in the context menu. In this mode, your document will be displayed as formatted as the way it will be presented when printed in Braille, according to the format BRF settings configured.
Please note that even though the format markers were disabled in the Keysoft’s settings, they will be displayed to help you apprehend more precisely the content of your future printed Braille document. Here are more explanations about the format markers.
To tell you how a document is formatted, KeySoft places special format markers at particular points in a document. These format markers are displayed on the Braille display. You may have encountered a number of special groups of symbols on the Braille display when you were reviewing your document. They tell you how the document is formatted. When displaying format markers, KeySoft follows the guidelines set for literary Braille format established by the Braille Authority of North America.
On the Braille display, if the cursor is positioned under a format marker, it appears under each of the characters of the format marker.
Format markers are groups of symbols that always start with a computer Braille dollar sign, $. In US computer Braille this is dots 1‑2‑4‑6 which is the same as the grade 2 "ed" contraction. In UK computer Braille it is dots 4‑5‑6. There is always a space before the $ and another space after the group of symbols. The symbol or symbols following the $ determine what the format marker is showing.
Here are the format markers that you will go through in your document.
New Line: $p.
Form feed: $f
Tab: $t 
5.15. [bookmark: _KeyBRF_commands_table][bookmark: _Toc209000114]KeyBRF commands table
The Braille Editor commands are listed in Table 3.
Table 3: KeyBrf Commands
	Action
	Shortcut or Key Combination

	Activate Edit mode
	Enter or a cursor-routing key

	Leave Edit mode
	Space + E

	Create braille file
	Backspace + B

	Open braille file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/stop selection
	Enter + S

	Select all 
	Enter + Dots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Space + Dots 1-2-4-5-6

	Increase Auto-Scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + dots 2-5-6

	Search in WordNet
	Space + D

	Toggle Reading mode 
	Space + X

	Where Am I? (Format BRF option  On)
	Space + Dots 1-5-6

	Preview mode (Format BRF option  On)
	Enter + V

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B



6. [bookmark: _Toc209000115]Record notes and listen to them with KeyRecorder (BI 40X only)
As the Brailliant BI 40X is equipped with a microphone, it is possible, on this device, to record notes. We created an app, KeyRecorder, that is designed to record notes simply and seamlessly and to listen to these files afterwards.
To open this app, when in the Main Menu, navigate until attaining Recorder: KeyRecorder, then press the ENTER key. The app contains two options that will be detailed below: “Record note” and “Open note”.
[bookmark: _Toc209000116]Record a note
To record a note, you have two options.
· From the app, you can use the option “Record note”. Press the ENTER key and the recording will start automatically. A message “Start recording” will be heard, then the word “Recording” will be written on the braille display.
· From anywhere on the device, you can use the shortcut ENTER + N to start a new recording. You will be directed to that same window, where the note is recorded.
To end your recording, please use the shortcut ENTER + X. The message “Stop recording” will be heard, then you will be returned to the main window of the app or where you were before on your device. An incremental number, for this new file, will be attributed, starting from number 1 (the first note) to the most recent one.
Please note: while recording, all the functions of your braille display are inactive. If you have to use your braille display for another purpose, it will be necessary to stop the recording in progress.
[bookmark: _Toc209000117]Listen to your notes 
To listen to your notes, use the option “Open note” that you will find in the Main menu of the app. A list of files, named incrementally from 1 to the total number of notes (from the first to the most recent recorded note) will be displayed.
In the “Open note” window, there is a Context menu that offers several items:
· Open: allows to open the current file where you are positioned.
· Info (Space + I): allows to obtain more information about the current file (name, path, type, size, date of the last modification and attributes).
· Consolidate notes: allows to replace some notes numbering filenames to ensure a continuity in the incremental numbering (it has to be used if you have previously deleted some notes).
· Rename (Backspace + R): allows to rename your note file. You can add A TEXTUAL NAME, THAT WILL BE ADDED AFTER THE NOTE NUMBER. 
· DELETE (BACKSPACE + DOTS 2-3-5-6): ALLOWS TO DELETE THE CURRENT FILE.
Pan in the list of files, then select the file you want to listen to with the ENTER key. The audio playing will start automatically.
While listening to your audio note, you can access a Context menu containing several options to facilitate your navigation:
· Go to: allows to navigate at a specific position in your file by time (enter minutes in digits only) or percentage.
· Where Am I?: allows to know your exact position in the current audio file, among other information such as the total time of the note, the time elapsed, the time remaining and the creation date.
· Play/Pause: as the option states, it allows to play/pause the listening of your audio note.
· Increase/decrease speed: as these options state, it allows to increase or decrease the speed of the audio that is playing.
Please note: you can access your audio notes by using the File manager, or you can export them by using your computer. In fact, these files are saved in the internal memory of your device, in the Notes folder, in MP3 format.
[bookmark: _Toc209000118]Shortcuts available in KeyRecorder
Shortcuts available in KeyRecorder are listed in Table 4.
Table 4: Shortcuts available in KeyRecorder
	Action
	Shortcut or key combination

	Record note
	Enter + N

	Stop recording
	Enter + X

	Pause/Resume recording
	Backspace + Enter

	Cancel recording
	Space + E

	Go to
	Enter + G

	Where Am I?
	Space + Dots 1-5-6

	Play/Pause
	Space + G

	Increase speed
	Enter + Dot 5

	Decrease speed
	Enter + Dot 2

	Info (about a note file)
	Space + I

	Rename (a note file)
	Backspace + R

	Delete (a note file)
	Backspace + Dots 2-3-5-6


Please note: most of the KeyRecorder shortcuts can also be found in the Main help menu of your device that you can access with the shortcut Space + H.
7. [bookmark: _Toc209000119]Using Victor Reader
Victor Reader is the application you use to read or listen to books on the BI X Series. It supports the following file formats:
· .brf
· .ebrl (eBraille)
· .pef
· .txt
· .html
· .docx
· .odt
· DAISY 2
· DAISY 2.02
· EPUB
· Niso
· .rtf
· .ban
· .bra
· .pdf
· .FB2
To open the Victor Reader app, press the Next thumb key until you reach Victor Reader, or press ‘V’ in the Main menu. Press Enter or a cursor routing key to access the app.
The Victor Reader menu includes Book List, recently read, Search, and Close.
7.1. [bookmark: _Toc209000120]Navigating the Book List
In Victor Reader, your books are stored in a Book List, comparable to a directory containing all the available media on your device in alphabetical order.
Use the Previous and Next thumb keys to select a book from your Book List, then press Enter or a cursor routing key.
Note that the BI X Series can display an error message if a PDF file book is opened. This generally occurs when the file contains images rather than text.
To close a book and return to the Book List, press Space + E or Space + B.
7.1.1. [bookmark: _Toc209000121]Searching for Books
To search for a specific book on the device: 
· Select Search from the Victor Reader menu or press Space + F. 
· Type in the text/name of book.
· Press Enter. You are presented with a list of books matching your search criteria. 
· Use the Previous and Next thumb keys to scroll to the book.
· Press Enter or a cursor routing key to open it.
7.1.2. [bookmark: _Toc209000122]Accessing Recently Opened Books
You can open a list of the last ten books you previously opened for quick access.
To open a list of the ten most recent books, press Enter + R or select Recently read from the Victor Reader menu. 
You can scroll through the ten most recent books using the Previous and Next thumb keys. Press Enter or a cursor routing key to open a book from the list.
7.1.3. [bookmark: _Toc209000123]Managing Your Books
When browsing the Book List, you can copy, move, or delete a selected book from the Victor Reader application to an external storage device. The actions that are available for each book depend on the type and location of the book. The Context menu tells you what actions are available.
The basic rules are:
· Books located on the USB storage can be deleted.
· Books downloaded from online services can be moved or deleted.
· Books can only be copied or moved to/from when external storage is connected. 
· You are unable to copy or move books from within the internal storage. 
To copy, move, or delete a book:
· Access the book list by pressing Space + B. 
· Select a book using the Previous or Next thumb keys.
· Press Backspace + M to open the Manage Book menu. 
· Select Copy to, move to, or Delete. 
7.2. [bookmark: _Toc209000124]Navigating and Accessing Additional Information in Books
The easiest way to navigate inside a book is by using the thumb keys. Use the Left and Right thumb keys to pan the text left and right. 
7.2.1. [bookmark: _Toc209000125]Changing the Navigation Level for Books
Victor Reader includes different navigation levels to make navigating through a book easier. Navigation levels are dependent on each book and may differ from book to book. 
To change the Navigation level:
· Press Space + T.
· Scroll through the available Navigation levels using the Previous and Next thumb keys.
· Press Enter or a cursor routing key to select the Navigation level.
Once the Navigation level is selected, use the Previous and Next thumb keys to navigate at this Navigation level. 
For example, if you selected the "Sentence" Navigation level, pressing the Next thumb key would move you from sentence to sentence within the book.
Alternatively, you can select the Navigation level of your choice using a quick shortcut:
· Press Backspace + Dot 6 to access the next Navigation level OR Press Backspace + Dot 3 to access the previous Navigation level.
· Press the Previous or Next thumb key to navigate within the book in the Navigation level selected. 
7.2.2. [bookmark: _Toc209000126]Navigating by Page, Heading, Percentage, or Bookmarks in a Book
To reach a specific page, heading, book percentage, or bookmark:
· Press Enter + G. 
· Scroll through the navigation options using the Previous and Next thumb keys.
· Choose between Page, Heading, Percent, or Bookmark.
· Note that the options available will vary based on the formatting available of the book.
· Press enter or a cursor routing key. 
· Enter a value.
· Press Enter.
7.2.3. [bookmark: _Toc209000127]Auto-Scrolling Through Text in Books in the Victor Reader App
The Auto-scroll feature of the BI X Series allows you to scroll through the text of an open book automatically. 
To turn On Auto-scroll, press Enter + Dots 1-2-4-5-6 or C6 (BI 40X only) when inside a book. Press any key to stop the Auto-scroll and return to the regular Panning mode.
You can modify the Auto-scroll speed when auto-scrolling inside a book. 
To slow down Auto-scroll, press Enter + Dot 3. 
To speed up Auto-scroll, press Enter + Dot 6.
7.2.4. [bookmark: _Toc209000128]Finding Your Current Position in a Book
Use the Where Am I command whenever you need to know your current position within a book. 
To activate the Where am I command, press Space + Dots 1-5-6.
Alternatively, access the Context menu by pressing Space + M. Go to Where am I using the Previous and Next thumb keys, then press Enter or a cursor routing key to activate the item.
Use the Previous and Next thumb keys to scroll through the available elements (Heading, Percent, Page, and Line). Use the Left and Right thumb keys to pan the text left and right.
7.2.5. [bookmark: _Toc209000129]Navigating to the Beginning or End of a Book
You can reach the beginning or end of a book using shortcuts. 
To reach the beginning of a book, press Space + Dots 1-2-3. 
To reach the end of a book, press Space + Dots 4-5-6.
7.2.6. [bookmark: _Toc209000130]Searching for Text in a Textbook
Another way to navigate within a book is to search for a specific string of text. 
To search for text, press the Space + F command. You are prompted to enter the text. Type the text, then press Enter.
7.2.7. [bookmark: _Toc209000131]Accessing Additional Book Information
You can display additional information about the book you are currently reading on the device (title, author, description, date, language, subject, publisher, and bookmarks).
To display additional book information, press Space + I. 
You can also press Space + M to open the Context menu. Use the Previous and Next thumb keys to select the Book Information menu item, then press Enter or a cursor routing key to activate it.
Use the Previous and Next thumb keys to scroll through the available book information. Use the Left and Right thumb keys to pan the text left and right.
7.2.8. [bookmark: _Toc209000132]Switch between text and audio in some DAISY/NISO books
Some DAISY/NISO books contain all the text and the audio. It is possible to read text or audio with our devices.
When a book, containing the full text and the full content in audio is opened, the text content is displayed. If you want to display the audio content, you can use the shortcut Space + Dots 2-3-5-6 or you can find this option in the Context menu. All the navigation functions that can be used in one of these modes or in the two modes are always available.
7.3. [bookmark: _Toc209000133]Search on Wikipedia, on Wiktionary and in WordNet
With Victor Reader, it is possible to obtain more information about a specific word by performing a search on Wikipedia, on Wiktionary or in WordNet. These 3 modules can be accessed via the Context menu of the app, or you can press the following shortcuts:
· Search on Wikipedia: Enter + W
· Search on Wiktionary: Enter + Dots 2-5-6
· Search in WordNet: Space + D
Note: You can obtain more information about these modules in the section 11 “Modules available in multiple applications”.
7.4. [bookmark: _Toc209000134]Adding, Navigating, Highlighting, and Removing Bookmarks
Bookmarks are a useful way to keep your location within the book and allow you to return quickly to that position at a later time, whether a physical position in a textbook or a time position in an audiobook.
To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
7.4.1. [bookmark: _Toc209000135]Inserting a Bookmark
To add a bookmark in a book:
· Press Enter + M to open the Bookmark menu. 
· Select Insert Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number. 
· Note: If you do not enter a number, BI X Series selects the first available number and assigns it to the bookmark.
· Press Enter. 
· Alternatively, you can insert a Quick Bookmark by pressing Enter + B.
7.4.2. [bookmark: _Toc209000136]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
7.4.3. [bookmark: _Toc209000137]Highlighting Bookmarks 
The Highlight Bookmarks menu item is used to define the Start and the End positions of a passage. Using highlighted bookmarks is a great way to study important passages in textbooks.
To highlight bookmarks:
· Open the Bookmark menu by pressing Enter + M.
· Select Highlight Bookmark Start using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter a specific unused bookmark number.
· Note: If you do not enter a number, your BI X Series selects the first available number and assigns it to the bookmark.
· Press Enter. 
· Navigate to the end point of the highlighted passage. 
· Open the Bookmark menu by pressing Enter + M. 
· Select Highlight Bookmark End using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
· The current position is set as the ending position. If the end position is placed before the start position, they are switched. 
You can also insert a Quick Bookmark. It is used to mark the end of the Highlight Bookmark.
To insert a Quick Bookmark:
· Press Enter + H to open the Highlight Bookmark list. 
· Select a Highlight Bookmark number.
· Press Enter. The content of the current Highlight Bookmark is displayed. 
· Use the thumb keys to navigate. 
· Press Space + E to close the Highlight Bookmark and return to the entire book content.
7.4.4. [bookmark: _Toc209000138]Removing Bookmarks
To remove a saved Bookmark:
· Press Enter + M to open the Bookmark menu. 
· Scroll to Remove Bookmark using the Previous and Next thumb keys.
· Press Enter or a cursor routing key. 
· Enter the Bookmark number you want to remove.
· Press Enter.
Note: If you want to remove all bookmarks type 99999 when prompted Bookmark number.
7.5. [bookmark: _Victor_Reader_and][bookmark: _Toc209000139]Victor Reader and Reading Commands Tables
The Victor Reader and reading commands for textbooks are listed in Table 5.
Table 5: Victor Reader/Reading Commands for textbooks
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Change to previous Navigation level
	Backspace + Dot 3

	Change to next Navigation level
	Backspace + Dot 6

	Start Auto-scroll
	Enter + Dots 1-2-4-5-6 or C6

	Increase Auto-scroll speed
	Enter + Dot 6

	Decrease Auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop reading (text-to-speech feature)
	Backspace + Enter

	Where am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Search for books or text
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Next non-blank line
	Enter + Dot 4

	Previous non-blank line
	Enter + Dot 1

	Previous character
	Space + Dot 3

	Next character
	Space + Dot 6 

	Previous word
	Space + Dot 2

	Next word
	Space + Dot 5

	Previous paragraph
	Space + Dots 2-3

	Next paragraph
	Space + Dots 5-6

	Start/Stop selection
	Enter + S

	Select all (current paragraph)
	Enter + Dots 1-2-3-4-5-6

	Copy (current paragraph)
	Backspace + Y

	Delete book
	Backspace + Dots 2-3-5-6

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + Dots 2-5-6

	Search in WordNet
	Space + D



Victor Reader and reading commands for audiobooks are listed in Table 6.
Table 6: Victor Reader Commands for audiobooks
	Action
	Shortcut or Key Combination

	Switch from text to audio (when in a DAISY/NISO book containing full text and audio)
	Space + Dots 2-3-5-6

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation Level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Change to previous Navigation level
	Backspace + Dot 3

	Change to next Navigation level
	Backspace + Dot 6

	Where Am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Delete book
	Backspace + Dots 2-3-5-6

	Play audiobook
	Space + G

	Stop the reading
	Backspace + Enter

	Fast forward 5 seconds
	Right thumb key (single press)

	Rewind 5 seconds 
	Left thumb Key (single press)

	Fast forward (Longer time jumps)
	Right thumb key (press and hold)

	Rewind (Longer time jumps)
	Left thumb key (press and hold)

	Increase reading speed
	Enter + Dot 5

	Decrease reading speed
	Enter + Dot 2


8. [bookmark: _Toc209000140] Using Terminal Mode
One of the main features of the BI X Series is Terminal mode. When connected to a host device running a screen reader, such as a computer or a smart device, terminal mode displays all text selected on the host device. 
You can connect to your host device either through Bluetooth® wireless technology, or by connecting the USB-C cable included with your BI X Series to the host device. Up to five Bluetooth devices and one USB can be connected at one time.
[bookmark: _Hlk144888720][bookmark: _Hlk144906194]Note that if a device is connected to the BI X Series via USB, you can have the BI X Series  automatically start the connection. See “Ask to open USB connection” in the User Settings Options Table for available settings options.
8.1. [bookmark: _Toc209000141]Connecting and Exiting Terminal Mode
To connect in Terminal mode, make sure you have a Windows®, iOS®, TVOS®, Android, WatchOS or Mac® device with a screen reader running.
To activate Terminal mode:
· Press Space + Dots 1-2-3-4-5-6 or the Home button to enter the Main menu.
· Go to Terminal by pressing ‘t’ or by using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
To exit Terminal mode and access the list of connected devices, press the Home button once.
8.1.1. [bookmark: _Toc209000142]Determining BI X Series Compatibility
The BI X Series is compatible with the following:
Screen readers: JAWS® 18+ (version 18 and newer), NVDA, SuperNova, Chromevox (USB only), Talkback 15+ and VoiceOver 
[bookmark: _Hlk181872795]Operating systems: Windows 8+, Android (15+ for Bluetooth support, USB only for previous versions), macOS® 10.15+ (Catalina), iOS device 13.4+, WatchOS 10+ and TVOS (Apple TV) version 18+ 
8.1.2. [bookmark: _Toc209000143]Waking Your iOS Device Using the BI X Series 
With your iOS device locked, pressing any cursor routing keys on the BI X Series wakes it up to enter your passcode. This allows you to keep your iOS device in a pocket or bag while you use the BI X Series as its controller and output.
8.1.3. [bookmark: _Toc209000144]Connecting by USB
To connect via USB:
· Connect the BI X Series to a Windows or Mac computer with the USB-C cable. Please note that you will have to follow the next steps if the “Always connect” option is not enabled in the user settings. 
· Select Connected devices (first item in the Terminal menu).
· Press Enter. 
· Select USB connection.
· Press Enter.
· Wait for the connection to be established. 
If the connection is successful, the content of your host device is shown on the braille display. 
The BI X Series is now also available as an external keyboard to type on the host device.
8.1.4. [bookmark: _Connecting_by_Bluetooth][bookmark: _Toc209000145]Connecting by Bluetooth
To pair a new device with Bluetooth:
· From the host device, activate Bluetooth.
· On the BI X Series, go to the Main menu.
· Select Terminal and press Enter or a cursor routing key. 
· In the Terminal menu, select Add Bluetooth device and Press Enter.
· If Bluetooth is Off, it is automatically activated. Note that once the Bluetooth mode is activated, your display is now in a 5-minute discoverable mode.
· Note that at any time, you can press and hold the Enter key for 5 seconds to set the device in a 5-minute discoverable mode.
· The braille display will prompt instructions on how to connect to the host device. From the host device, initiate the Bluetooth pairing with the BI X Series.
· On the braille display, a message will prompt: “xx is connected”, where xx is the name of the host device. The focus is directed to the list of connected devices.
· Use the Previous and Next thumb keys to move through the list of connected devices until you reach the host device you are trying to connect with. Press Enter or a cursor routing key to activate it.
If the connection is successful, the content of your host device is shown on the braille display. 
Note: If you use Windows 11 with Bluetooth connectivity, you may need to access your PC's Bluetooth settings and select "Advanced" under "Bluetooth devices discovery." Failure to do so may result in braille displays not appearing in the list of pairable devices.
Note: to pair an audio Bluetooth device, you will have to use the “Pair audio device” option in the Bluetooth settings (see section 13.5 about Bluetooth settings for more information). 
8.2. [bookmark: _Toc209000146]Terminal Clipboard
When a selection of text is copied or cut, it is stored in a global clipboard and can be pasted on other locations on the device. This feature can be useful if, for example, you wish to copy a passage from a book in Victor Reader and paste it into a document in KeyPad. 
The global clipboard can also be used when using external devices paired with the BI X Series via USB or Bluetooth. Currently, JAWS for Windows and VoiceOver are supporting the terminal clipboard. All other screen readers might have difficulty in handling the clipboard.  When using the Terminal clipboard, please note there is a 360 character limitation.
To copy an item to a connected device:
· Press Backspace + Y to copy the element of your choice.
· On the connected device, access the location where you wish to paste the item.
· Enter the bypass command Space + Enter + Dots 4-5-6. The message “Enter local command” will be displayed. The bypass command allows you to use some internal functions on the BI X Series while being connected to an external device, such as the Battery Status, and showing the Date and Time. 
· Press Backspace + V to paste the item on the connected device.
8.3. [bookmark: _Toc209000147]Navigating Between Connected Devices
When you have more than one device connected with the BI X Series, you can switch devices at any time. 
To switch to another connected device, press the Home button + Next thumb key or Home button + Previous Thumb key.
Alternatively, you can navigate to another connected device by doing the following: 
· Press the Home button to return to the list of connected devices.
· Select the connected device using the Previous and Next thumb keys.
· Press Enter or a cursor routing key.
Note: When a Bluetooth device is connected, an 8-dot symbol is displayed after the device name. If the 8-dot symbol is not visible, click on the device to establish the connection. 
If you have problems with a Bluetooth connection, you can click on Reconnect devices. This turns Bluetooth Off and back On and reconnects your devices. Use this option if you are not getting any braille when connected to a device.
8.4. [bookmark: _Toc209000148]USB connections in Terminal mode
When using the BI X Series in terminal mode, it is possible to either be prompted to connect with a USB connection or automatically start the connection upon inserting a USB cable from a host device.
To activate the “Ask to open USB connection” feature in terminal mode:
· Go to the Main menu.
· Select Options and press Enter. 
· Select User Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the item “Ask to open USB connection”, then press Enter.
· Here, 3 options are available: “Never ask”, “Ask for connection” and “Always connect”. Use the Previous and Next thumb keys until you reach the item you require, then Press Enter.
8.5. [bookmark: _Toc146102242][bookmark: _Toc146102416][bookmark: _Toc146102579][bookmark: _Toc146103149][bookmark: _Toc209000149]Disable Perkins Keyboard in Terminal Mode
When using the BI X Series in terminal mode, it is possible to disable the Perkins-style keyboard to simplify your use of the device. 
To disable the keyboard in terminal mode:
· Go to the Main menu.
· Select Options and press Enter. 
· Select User Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the item Disable Perkins in terminal.
· Press Enter to disable the Perkins keyboard in terminal mode; press Enter again to enable it.
Note that the BI X Series thumb keys and command keys (BI 40X only) will still be working when the Perkins keyboard is disabled.
8.6. [bookmark: _6.6._Terminal-only_mode][bookmark: _Terminal_only_mode][bookmark: _Toc209000150]Terminal only mode
Consider enabling 'Terminal only mode' on your braille display if you find that the standalone KeySoft suite applications are underutilized or too complex. This mode removes internal applications, transforming the display into a terminal only. It streamlines connections to screen readers on your computer via USB or on your mobile device via Bluetooth. To activate or de-activate the Terminal Only mode, you will have to access the diagnostic menu (see section 19 “Accessing the diagnostic menu”). 
In Terminal only mode, when booting the device, you are prompted ‘braille display’. If your device is plugged into a computer, it will work with your screen reader instantly.
Please note: this mode comes with the following limitations. 
· Text-to-speech is not available. You will only have access to braille.
· All menus will be displayed in grade 1 and will not be configurable. 
· Sleep mode is not present in Terminal only mode. It remains possible to manually put the device in Sleep mode by doing a short press on the Power button.  
· Only one Bluetooth device can be connected and paired in this mode. When activating the Terminal only mode, if more than one Bluetooth device had been previously configured on your device, All the devices except one will be forgotten and you will have to pair them again if you want to use them in the future. 
· If one device is connected on Bluetooth and another on USB at the same time, the device connected on USB connection will always have priority. 
· Accessing and exiting the options menu is different when Terminal Only mode is enabled. A limited set of options will be available, (see section 7.6.1 about the options in Terminal only modesection 7.6.1 about the options in Terminal Only mode). 
· The Bypass local command is not working in this mode. For example, you will not be able to copy/paste some text from the terminal clipboard as described in section 7.2.
8.6.1. [bookmark: _6.6.2_Using_the][bookmark: _Using_the_Options][bookmark: _Toc209000151]Using the Options in Terminal Only mode
To use the options in Terminal only mode, press and hold the Home button until you feel a short vibration. To exit the Options, press and hold again the Home button.
Here are the options available in Terminal only mode:
· User settings: airplane mode, message display time, auto power off, vibration, beep, wireless notifications, one-handed mode, disable perkins in terminal.
· Wi-Fi
· Bluetooth
· Change language
· Activate exam mode
· Software update
· About
9. [bookmark: _Toc209000152]Using KeyFiles
KeyFiles allows you to browse, delete, copy, and perform all the file operations you would expect from a PC file manager.
To open KeyFiles, press the Next thumb key until you reach File Manager : KeyFiles. 
Alternatively, you can open KeyFiles by pressing F in the Main menu, then press Enter or a cursor routing key.
9.1. [bookmark: _Toc209000153]Browsing Files
You can browse through your files and folders using the Previous and Next thumb keys. Folder names have an 8-dot symbol in front of the folder name. Press Enter on a folder to open it.
Press Space + E to return to the parent folder. Alternatively, you can scroll to the Back item, then press Enter or a cursor routing key.
9.1.1. [bookmark: _Toc209000154]Selecting a Drive in KeyFiles
Before using KeyFiles, you first need to choose which drive you wish to access: the internal memory or a USB flash drive. 
To select a drive, press Space + D to display a list of available drives. Scroll through the list using the Previous or Next thumb keys, then press Enter or a cursor routing key to confirm your choice. 
You are now at the root of your selected drive.
Press Space + D at any time to return to the Drive Selection screen.
9.1.2. [bookmark: _Toc209000155]Accessing File, Folder, or Drive Information
To get additional information on a file or folder, select it using the Previous or Next thumb keys, then press Space + I.
You can now scroll through a list of information on the file or folder using the Previous and Next thumb keys. Use the Left and Right thumb keys to pan the text left and right.
The Space + I shortcut can also be used to expose the amount of internal memory of a drive.
9.1.3. [bookmark: _Toc209000156]Displaying the Current File Path
The Where Am I function allows you to display the path of your current location on the braille display of the BI X Series.
To display your current file path, press Space + Dots 1-5-6.
9.1.4. [bookmark: _Toc209000157]Searching for Files and Folders
You can promptly access a certain file or folder by performing a search in KeyFiles.
To start searching for a file or folder in KeyFiles:
· Press Space + F.
· Type in the file or folder name.
· Press Enter. A list of files and folders related to your search results is generated on the braille display.
· Press Space + E to close the search result.
9.1.5. [bookmark: _Toc209000158]Sorting Files or Folders
By default, file and folder names are sorted alphabetically. However, you can sort the files and folders using different parameters.
To change the sorting parameters of your files and folders:
· Press Space + V. BI X Series displays a list of sorting options available: Name, Date, Size, and Type. 
· Scroll through the list using the Previous or Next thumb key.
· Press Enter or a cursor routing key to activate the sorting option of your choice. 
Selecting the same sorting parameter already selected, changes the information from ascending to descending and back again when selected once more.
9.2. [bookmark: _Toc209000159]Modifying Files and Folders
KeyFiles on the BI X Series lets you work with files similarly to a computer or tablet. 
9.2.1. [bookmark: _Toc209000160]Creating a New Folder
KeyFiles gives you the possibility to create new folders. 
The simplest way to do this is by pressing Space + N and entering the name of the new folder in the blank field. Then, press Enter to create it.
9.2.2. [bookmark: _Toc209000161]Renaming Files or Folders
To rename a file or folder:
· Select the file or folder you wish to rename using the Previous and Next thumb keys. 
· Press Backspace + R.
· Enter the new file or folder name.
· Press Enter to rename the file or folder.
Note: The file name must be unique in your current directory, and only one file or folder can be renamed at a time. 
9.2.3. [bookmark: _Toc209000162]Selecting Files or Folders for Applying Additional Actions
Before you can perform an action on a file or folder, such as cut, copy, or paste, you must first select (or Mark) the desired file or folder. 
To Mark a file or folder, select the file using the Previous or Next thumb keys, then press Backspace + L.
To Unmark a file or folder, select it and press Backspace + L again.
To Mark All files and folders in the current directory, press Enter + Dots 1-2-3-4-5-6.
9.2.4. [bookmark: _Toc209000163]Copying, Cutting, and Pasting Files or Folders
Copying and Cutting Files and Folders
To copy a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + Y.
To cut a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + X.
To copy or cut multiple files or folders: 
· Select the file or folder to copy using the Previous or Next thumb keys. 
· Press Backspace + L to Mark the file or folder.
· Repeat this step to Mark all files or folders to be copied.
· Press Backspace + Y to copy OR Backspace + X to cut. 
The files or folders are now copied/cut to the clipboard and ready to be pasted.
Pasting Files and Folders
To paste the copied or cut files or folders, navigate to the location where you want to paste to, then press Backspace + V.
9.2.5. [bookmark: _Toc209000164]Deleting Files or Folders
To delete a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + Dots 2-3-5-6.
To delete multiple files or folders:
· Select the file or folder you wish to delete using the Previous or Next thumb keys. 
· Once selected, press Backspace + L to Mark the file or folder.
· Repeat this step to Mark all files or folders you wish to delete.
· When ready to delete the Marked files or folders, press Backspace + Dots 2-3-5-6. 
Note: BI X Series asks if you are sure you want to delete the files and/or folders only when user Confirm Deletion has been set to On in the Options menu. Select Yes using the Previous or Next thumb keys, and press Enter or a cursor routing key to confirm the deletion. For more information on the Confirm Deletion setting, go to the Options Menu section.
9.3. [bookmark: _Toc209000165]KeyFiles Commands Table
The KeyFiles commands are listed in Table 7.
Table 7: KeyFiles Commands
	Action
	Shortcut or Key Combination

	Create new folder 
	Space + N

	File/drive info 
	Space + I

	Mark/Unmark
	Backspace + L

	Mark all/Unmark all 
	Enter + Dots 1-2-3-4-5-6

	Rename file
	Backspace + R

	Delete file
	Backspace + Dots 2-3-5-6

	Copy file 
	Backspace + Y

	Cut file
	Backspace + X

	Paste file
	Backspace + V

	Search file 
	Space + F

	Sort files 
	Space + V

	Where am I 
	Space + Dots 1-5-6

	Select drive 
	Space + D

	Go to parent folder
	Space + E

	Eject media
	Enter + E



10. [bookmark: _Toc209000166] Using the KeyCalc Application
The BI X Series features a calculator app that enables you to perform the most common operations. 
Note: KeyCalc currently supports Computer Braille only. 
To open KeyCalc:
· Go to the Main menu.
· Press C OR press the Previous or Next thumb keys until you reach the Calculator: KeyCalc menu item. 
· Press Enter or a cursor routing key.
10.1. [bookmark: _Toc209000167]Operating the Calculator
To use KeyCalc, write your complete equation, then press Enter to get the result. 
For example, type the equation 20-(6+8) (with no spaces). Press Enter and BI X Series display 6 as the answer.
To clear the previous equation, press Space + Dots 3-5-6.
To add operators such as + or -, open the Context menu using Space + M. Refer to the KeyCalc Commands Table section, for a full list of KeyCalc commands and operators.
10.2. [bookmark: _KeyCalc_Commands_Table][bookmark: _Toc209000168]KeyCalc Commands Table
The KeyCalc commands are listed in Table 8.
Table 8: Calculator Commands using US Computer Braille
	Action
	Shortcut or Key Combination

	Plus 
	Dots 3-4-6

	Minus
	Dots 3-6

	Multiply
	Dots 1-6

	Divide
	Dots 3-4

	Equals
	Enter

	Clear 
	Space + Dots 3-5-6

	Decimal point
	Dots 4-6

	Percent
	Dots 1-4-6

	Square root 
	Space + Dots 3-4-5

	Pi
	Space + Y


11. [bookmark: _Toc209000169] Using the Date and Time Application
The BI X Series features an application that gives you the current date and time. 
To open Date and Time:
· Go to the Main menu.
· Press the Previous or Next thumb keys until you reach the Date and Time menu item.
· Press Enter or a cursor routing key.
11.1. [bookmark: _Toc209000170]Displaying the Time and Date
When you open the Date and Time application, BI X Series displays the current time. 
Pan right once using the Right thumb key to display the date. 
Pan left using the Left thumb key to return to the time. 
To quickly review the date and time, press Enter + T for the time and Enter + D for date from anywhere on the BI X Series.
11.2. [bookmark: _Toc209000171]Setting the Time and Date
To change the time and date, press Space + M from the Date and Time application.
A submenu opens with the following options: 
· Change time: Type the current hour inside the square brackets, press Enter; repeat for the minutes.
· Change date: Type the current year inside the square brackets and press Enter; repeat for the month and day.
· Daylight saving time: Press Enter to turn daylight saving time On or Off.
· Time format: Press Enter to change between 24h and 12h time format.
· Date format: Select the preferred date format (listed below) and press Enter. 
· Language Default
· Day, Month, Year 
· Month, Day 
· Month, Day, Year 
· Year, Month, Day 
· Day, Month
12. [bookmark: _Modules_available_in][bookmark: _Toc209000172]Modules available in multiple applications
Some modules are available in multiple applications. For now, it is possible to search on Wikipedia, on Wiktionary and in WordNet in the Editor (Keypad), Braille Editor (KeyBRF) and Victor Reader app. 
12.1. [bookmark: _Toc209000173]Search on Wikipedia
If you would like to obtain more information about a specific word in your document or book (e.g. its definition, other occurrences, biography of a famous personality, etc.), you can search on Wikipedia. This module can be used in text and audio documents and books. To do so, when in your document and with the cursor positioned on the word that you want to look at, you can use the shortcut Enter + W or you can find this option in the Context menu, under the Edit submenu. For Victor Reader app, this option can be found directly in the Victor Reader’s menu, in the Context menu. The word under the cursor is selected and typed by default in the “Wikipedia” field. You can directly press Enter to search for this specific word on Wikipedia, or you can erase this word and enter another word to search. Please note that in audio and braille books, you will have to enter the word to search in the field. Press Enter to complete the search.
The results associated to this specific search will be displayed. You will see the number, followed by the name of the article, then a short summary of the article will be available. You can use the left and right thumb keys to go through all the information displayed for an article, and you can use the previous and next thumb keys to navigate from one result to another. When your cursor is positioned on the desired result, press Enter to open this article.
You can now read the article that is displayed in text. You can navigate through the text by using the left and right thumb keys, or the previous and next thumb keys to navigate through the headings in the article. It is also possible to use the shortcut Space + G and the voice will read all the article. You can also find a specific word in the article by using the shortcut Space + F. In the box that will be displayed when using this shortcut, enter your desired word to search for, then press Enter. The nearest occurrence of this word from the position of the cursor will be displayed. The shortcuts Space + N to navigate to the next occurrence of your search and Space + P to go to the previous occurrence can also be used. When you have finished reading the article, press Space + E or the Close button.
Note: the article can only be read: it cannot be copy-pasted or saved. While reading an article, you will not have access to the context menu. Please note that articles listed in the search results will be displayed using the selected braille table of your current language profile. For example, if you are using a language profile set to French with a French Braille table configured, articles listed in the results will be in French. Finally, to use the “Search on Wikipedia” option, you have to be connected to the Internet. If it is not the case, an error message will be displayed when you try to perform the search.
12.2. [bookmark: _Toc209000174]Search on Wiktionary 
As for the option “Search on Wikipedia”, the option “Search on Wiktionary” can be used to search for a definition of a specific word. To do so, when your cursor is positioned on the desired word, press the shortcut Enter + Dots 2-5-6 or you can find this option in the Context menu, under the “Edit” submenu. For the Victor Reader app, this option can be found directly in the Victor Reader’s menu, in the Context menu. The word under the cursor will be selected and typed by default when in the “Wiktionary” field. You can change the word entered by erasing it then entering a new one, or you can keep this specific word. Please note that when in an audio and braille book, you will have to enter the word to search for. Press Enter to perform the search. Results for this search will be displayed. You can navigate through the information for each article with the left and right thumb keys, and through the results with the Previous and Next thumb keys. When on the desired article, press Enter to open it.
You can now read the article that is displayed in text. You can navigate through the text by using the left and right thumb keys, or the previous and next thumb keys to navigate through the headings on the article. It is also possible to use the shortcut Space + G and the voice will read all the article. You can also find a specific word in the article by using the shortcut Space + F. In the box that will be displayed when using this shortcut, enter your desired word to search for, then press Enter. The nearest occurrence of this word from the position of the cursor will be displayed. The shortcuts Space + N to navigate to the next occurrence of your search and Space + P to go to the previous occurrence can also be used. When you have finished reading the article, press Space + E or the Close button.
Note: the article can only be read: it cannot be copy-pasted or saved. While reading an article, you will not have access to the context menu. Please note that articles listed in the search results will be displayed using the selected braille table of your current language profile. For example, if you are using a language profile set to French with a French Braille table configured, articles listed in the results will be in French. Finally, to use the “Search on Wiktionary” option, you have to be connected to the Internet. If it is not the case, an error message will be displayed when you try to perform the search. 
12.3. [bookmark: _Toc209000175]Search in WordNet
WordNet is a lexical database owned by Princeton University. You can search in this lexical for specific words. To access this resource, press the shortcut Space + D or access it via the Context menu, under the Edit submenu. For Victor Reader app, this option can be found directly in the Victor Reader’s menu, in the Context menu.
In the “WordNet” field, you will be able to enter the searched word, then press Enter to begin the search. The definition of this word is displayed. You can navigate through the text with the left or right thumb keys and through the different paragraphs using the Previous and Next thumb keys. It is also possible to use the shortcut Space + G and the voice will read all the article. You can also find a specific word in the article by using the shortcut Space + F. In the box that will be displayed when using this shortcut, enter your desired word to search for, then press Enter. The nearest occurrence of this word from the position of the cursor will be displayed. The shortcuts Space + N to navigate to the next occurrence of your search and Space + P to go to the previous occurrence can also be used. When you have finished reading it, press Space + E or the Close button.
Note: the article can only be read: it cannot be copy-pasted or saved. While reading an article, you will not have access to the context menu. Finally, please note that WordNet is only available in English. WordNet determines your language by checking the Braille table configured in the language profile you are using. To use WordNet, your Braille table configured has to be in English.
12.4. [bookmark: _Toc209000176]Shortcuts available in modules that can be used in multiple apps
Shortcuts for modules that work in multiple aps are displayed in table 9.
Table 9: Shortcuts for modules that work in multiple apps
	Action
	Shortcut or key combination

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + Dots 2-5-6

	Search in WordNet
	Space + D



13. [bookmark: _Options_Menu_1][bookmark: _Toc209000177] Options Menu
The Options menu allows you to modify the settings of your BI X Series, and contains the following items:
· User settings
· Language profile
· Speech settings
· Wi-Fi
· Bluetooth
· Main menu applications 
· Change language
· Activate exam mode
· Software update
· About
To open the Options menu, press the Next thumb key until you reach Options or press ‘O’ in the Main menu, then press Enter or a cursor routing key. Alternatively, you can access the Options Menu by pressing Space + O.
14. [bookmark: _User_Settings][bookmark: _Toc209000178]User Settings
14.1. [bookmark: _User_Setting_Options][bookmark: _Toc209000179]User Settings Options Table
The user Settings options are listed in Table 10.
Table 10: User Settings Options 
	Setting
	Option/Result

	Airplane mode
	On or Off; when On, all wireless functionalities are disabled

	Format markers
	On or Off; when Off, format markers are hidden

	Cursor visible
	On or Off

	Cursor blink
	On or Off; when On, the cursor will blink at a rate of 0.5 seconds.

	Message display time
	1–30 seconds: time of message displayed 

	Sleep time
	Number in minutes, from 0 to 60; 0 to turn Off

	Auto Power off
	The device shuts down automatically after a determined period of time, from 1 to 4 hours; never to turn off 

	Word wrap
	On or Off

	Condense blank lines
	On or Off; when On, blank lines are not visible

	Confirm delete
	On or Off; when On, BI X Series asks for confirmation of file deletion

	Vibration
	On or Off; when On, BI X Series vibrates

	Beep
	On or Off; when On, BI X Series beeps

	Thumb keys configuration
	Map the Previous Item, Next Item, Pan Left, and Pan Right commands to the thumb key of your choice.

	Command keys configuration (BI 40X only)
	Allows to configure the command keys with any shortcut used in the device.

	Wireless notifications
	Enable or disable wireless and Bluetooth connection feedback

	One-handed mode
	On or Off; when On, dots keys can be pressed and released one-by-one, the dot combination is only confirmed once the Space key is pressed

	Start in terminal
	On or Off; when On, the device will automatically start in the Terminal menu upon restarting

	Ask to open USB connection
	When connecting the device to a PC with a USB cable, there are three possible outcomes depending on the selection of Ask to open USB connection in the user settings. 

1. If “never ask” is selected, nothing happens. 

2. If “ask for connection” is selected, the user will be asked if they want to open the connection. 

If “always connect” is selected, the device will automatically connect to the PC. 

	Disable Perkins in terminal
	On or off; when On, the Perkins-style keyboard will be disabled when the device is used in terminal mode

	Dot firmness (BI 40X only)
	This option allows to configure the dot firmness. By default, it is set at “medium”, but you can decrease the dot firmness by setting the option to “low” or increase it by setting the option to “high”. Please note that when decreasing the dot firmness at “low”, some ghost dots could appear, meaning that some points will not disappear when the corresponding text will not be displayed. Please also note that increasing the dot firmness to “high” could decrease the battery life.

	NLS BARD settings
	Allows to choose the book types to search in your NLS BARD account. You can choose between Braille, audio and both.

	MTP
	Enables or disables Media Transfer Protocol. When enabled, the device can connect to a computer as a media device, allowing file transfer via USB. When disabled, USB connection will be limited to charging and terminal mode.


14.1.1. [bookmark: _Toc209000180]Command keys configuration (BI 40X only)
One of the user settings of the BI 40X allows you to configure the command keys. Those keys are located on the left (keys C1, C2 and C3) and on the right (keys C4, C5 and C6) of your braille display and have different functions. Below is the list, containing each command key and its shortcut by default.
C1: previous item
C2: pan left
C3: next item
C4: Switch language profile (if more than one profile had been configured)
C5: pan right
C6: Start auto-scroll 
To change the shortcut associated to a command key:
· On the User settings submenu, press on the Enter key or any cursor-routing key on the “Command keys configuration” item.
· On this submenu, you will see each of the 6 command keys, with their personalized shortcut configured, if any. If not, it will be mentioned “default”, indicating that the command key kept its original function.
· To change the shortcut associated to a command key, navigate until finding the desired one, then press on the Enter key or any cursor-routing key.
· The message “enter braille command” will be displayed. Enter the shortcut that you want to associate to this command key.
· The new shortcut will be indicated as soon as you will be done writing it.
· You can always modify this shortcut by pressing the Enter key on the desired command key then by entering a new shortcut.
· To save your configuration, press on the Enter key on the “Save configuration” button.
· To cancel the operation, press on the “Cancel” button.
Please note: the newly configured command key will perform the selected shortcut in any application on your device. The default shortcut of this command will no longer be accessible, and you will have to find an alternate way to do it. For example, to begin the auto-scroll in KeyPad, KeyBRF and Victor Reader, the C6 key could be used. If you change the shortcut associated with the C6 key, you will have to use the shortcut Enter + Dots 1-2-4-5-6 to begin Auto-scroll. 
Finally, to restore the default value of a command key, when the “Enter Braille command” message is displayed, press on that command key.
14.2. [bookmark: _Toc209000181]Adding, Configuring, and Deleting Language Profiles
The Language Profile menu lists all the available language Profiles on your BI X Series. The active language Profile is underlined with dots 7 and 8 on the device. Creating multiple language profiles can allow you to easily switch quickly between braille tables and voices.
Scroll through the available language Profiles using the Next and Previous thumb keys, then press Enter or a cursor routing key to select it.
14.2.1. [bookmark: _Toc209000182]Adding a Language Profile
To add a language Profile, select Add language Profile, then press Enter or a cursor routing key.
You are prompted to enter the following options:
· Profile name: Type the name for the profile in the brackets, then press Enter.
· Braille grade: Choose between Uncontracted, Contracted, and Computer braille, then press Enter. Note that the BI X Series allows you to hide contracted braille and/or computer braille when toggling between the Braille grades.  
· Computer braille table: Select your computer braille table, then press Enter. Select none to avoid Computer braille toggle.
· Uncontracted braille table: Select your uncontracted braille table, then press Enter. 
· Contracted braille table: Select your contracted braille table, then press Enter. Select none to avoid Contracted braille toggle.
· [bookmark: _Hlk181979951]Content Voice: Select the content voice of your choice, then press Enter. Select None to turn the Content voice off. Voices available depend on your selection for the menu voice and additional voice, which can be changed from the download language and voices section within the Speech settings. 
· Save configuration: Press Enter to save your configuration. 
· The new language Profile is now available in the language Profile Settings menu.
14.2.2. [bookmark: _Toc209000183]Configuring or Deleting a Language Profile
To configure or delete a language Profile:
· In the Options menu, select the item language Profile. 
· Scroll through the available language Profiles using the Next and Previous thumb keys.
· Press Space + M to open the Context menu. 
· Select Configure language Profile OR Delete language Profile and press Enter.
· Alternatively, configure profile and Delete profile can be selected in the language profile menu.
14.3. [bookmark: _Toc209000184]Text-to-speech
The BI X Series allows for the text that appears on the braille display to be heard via a text-to-speech (TTS) feature, which will adapt to the system language chosen.
Note that by default, the device only supports TTS for English and Spanish languages. If you have English or Spanish selected as your system language, then TTS will be activated. If an alternative language is chosen, then you will be prompted to download that language upon having an active network connection.
Please note that the first time the BI X Series will be connected to a Wi-Fi network after the update or a factory reset, and no matter if a voice is active by default or not, a dialog will prompt inviting you to download language and voices. 
To activate/deactivate the text-to-speech feature:
· In the Options menu, select the item Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach Speech settings.
· Press Enter to toggle the Speech settings On or Off.
Alternatively, you can use the Previous Thumb Key + Space shortcut to toggle the Speech feature On or Off.
While editing text in KeyPad or reading a document in Victor Reader, you can press Space + G, which will start reading the text from the current position. Use the Backspace + Enter shortcut to stop reading.
Note: When using the KeyBrf application, TTS will not be available.
14.3.1. [bookmark: _Toc209000185]Voice Selection
While navigating the device, you can select a menu voice that will be used to read menus, system messages and content. If you wish to use an alternative voice for your content reading, you can do so by selecting the change additional voice item. Your content voice can then later be changed within the language profiles. 
14.3.1.1. Change menu voice
· In the Options menu, select Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the download language and voices selection item and press Enter. A submenu will appear.
· Choose Change Menu Voice (current voice will be specified) and press Enter.
· Select the variant of your system language (for example, English North America) that you want if more than one is available.
· A list of available voices will appear. Choose a voice from the list and press Enter.
Any changes to the voices will require a restart of the device.
14.3.1.2. Change an additional voice
· In the Options menu, select the item Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the download language and voices selection item and press Enter. A submenu will appear.
· Choose Change Additional Voice (current voice will be specified) and press enter.
· Select the desired language, then the language variant (for example, French Canada) that you want, if more than one is available.
· A list of available voices will appear. Choose a voice from the list and press enter.
Any changes to the voices will require a restart of the device.

For information about selecting a Content voice, which will read content in KeyPad and Victor Reader, please see the section "Adding, Configuring, and Deleting Language Profiles".
14.3.1.3. Swap voices
This option allows you to swap between the two voices installed on your device. To do so:
· In the Options menu, select the item Speech Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the “download language and voices” selection item and press Enter. A submenu will appear.
· Choose the option “Swap voices”, then press Enter.
Any changes to the voices will require a restart of the device.
14.3.2. [bookmark: _Toc209000186]Speech Settings Table
Table 11: Speech Settings Options 
	Setting
	Option/Result

	Speech
	On or off; when off, all speech features are disabled.

	Speak menu
	On or off; when off, all speech features are disabled while navigating in the menus, but stay enabled in the applications.

	Speak word under cursor
	On or off; when on, the user can press on a cursor routing key and the word below the key will be read.

	Speak display content after panning
	On or off; when on, the speech feature will read the remainder of a line when the user pans it on the braille display.

	Echo delete
	On or off; when on, the device will speak the characters deleted with the Backspace key.

	Keyboard echo
	Words, Characters, Characters and Words or Off; the item chosen determines what will be spoken when typing on the keyboard.

	Download language and voices
	Change menu voice, change additional voice, swap voices


14.4. [bookmark: _Toc209000187]Connecting to a Wi-Fi Network
[bookmark: _Hlk144887703]Select New Connection from the Wi-Fi menu, then press Enter or a cursor routing key to access it. You can also use the global shortcut to access the Wi-Fi search (note that if airplane mode is enabled, it will disallow access).
There are three connection choices:
· Scan for SSID: Select this option to discover the available networks in your vicinity. When BI X Series is done scanning, it displays a list of all the networks it found.
· Select one of them, then Press Enter or a cursor routing key to select this network. Then enter the password, and press Enter to complete the connection.
· WPS Connection: Select this option to establish a Wi-Fi Connection using WPS. The BI X Series displays “loading...” for approximately 30 seconds. Press the WPS button on your network Router to turn on discovery of new devices. After a few seconds, you are automatically connected to the network.
· Manually Connect: To enter the SSID of your network and the password manually, select this option. When done, press Enter to connect.
14.4.1. [bookmark: _Toc209000188]Wi-Fi Settings Table
The available Wi-Fi Settings are listed in Table 12.
Table 12: Wi-Fi Settings
	Setting
	Option/Result

	Wi-Fi
	Press Enter to turn Wi-Fi On or Off

	Status
	Provides information about your current Wi-Fi status

	New connection
	Press Enter to create a new Wi-Fi connection

	Launch connection
	Connect to a Wi-Fi network known by your device

	Delete connection 
	Make your device forget a known Wi-Fi network

	Network settings
	Change advanced network settings, such as Mode, IP, Subnet mask, Gateway, and DNS

	Import Wi-Fi
	Import Wi-Fi network information from a file


14.5. [bookmark: _Choosing_Bluetooth_Mode][bookmark: _Toc209000189]Choosing Bluetooth Mode Options
The following Bluetooth mode options are available on the BI X Series.
· Bluetooth mode: On or Off
· Pair audio device: this option allows you to pair an audio Bluetooth device.
· Connect device: Connect the BI X Series with a paired Bluetooth device.
· Disconnect device: Disconnect the active Bluetooth connection
· Delete paired device: Makes your device forget a Bluetooth device
15. [bookmark: _Toc209000190][bookmark: _Hlk182517623]Customize KeySoft’s Main Menu
The Customization function allows you to take items off the Main menu of the BI X Series. This feature is useful for beginners who wish to simplify the usage of their device.
To customize the main menu applications:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Go to Main menu applications.
· Press Enter.
· A list of the Main menu applications will appear. Go to the application you wish to take off the menu, and press on Enter to toggle it to Off. Pressing Enter again will toggle it back to On.
· Press on Save to apply the changes.  
16. [bookmark: _Toc209000191][bookmark: _Hlk144893686]One-Handed Mode
The BI X Series can be used in a one-handed mode that allows entering shortcuts with only one hand. When the one-handed mode is activated, the way that Braille input and commands are performed changes. Each key can be pressed and released one by one, and the dot combination is only confirmed once the space key is pressed. To insert a blank space between words, press the space bar twice. 
To perform braille commands, the same logic is used for the input of characters. For Braille commands that involve the space bar, such as the Go to top (Space with dots 1,2,3) command, an additional space bar press is required. 
For example, to perform the Go to top command (standard command is space + dots 1,2,3): press space, then dot 1, then dot 2, then dot 3, then space. 
Note: the operation of the thumb keys and cursor routing keys remains the same as with the standard two-handed mode.
To activate/deactivate the one-handed mode:
· Go to the Main menu.
· Select Options and press Enter. 
· Select User Settings and press Enter.
· Use the Previous and Next thumb keys until you reach the One-handed mode item.
· Press Enter to activate the One-handed mode; press Enter again to deactivate it.
17. [bookmark: _Toc209000192]Change Language
To change the system language of the BI X Series:
· Go to the Main menu.
· Select Options.
· Select Change Language.
· Select the Language option and press Enter. A list will appear on the display. 
· Select the language of your choice from the list. 
· Select Close.
· You will be prompted to select the option Replace language default profile. If you click on Ok, a new language profile will be created with a Braille table allowing to read Braille menus in the selected language. Press Cancel if you wish to stay with your current language profile.
· When prompted, reboot the BI X Series to apply the changes. 
18. [bookmark: _Toc209000193]Accessing and Using Online Services
This Online Services menu contains online libraries included on your BI X Series. The Online Services are subscription-based and require you to enter your account credentials.
Note: Make sure you have an established internet connection with the BI X Series before using Online Services. 
Books from online libraries are downloaded in the Online-books folder of the BI X Series. All books are included in the Main Book list of the Victor Reader application.
18.1. [bookmark: _Toc209000194]Activating Bookshare and Downloading Books
Bookshare® online library contains copyrighted content for people with qualifying print disabilities. More information about Bookshare is available from http://www.bookshare.org. 
You are able to search for text and audio (daisy or brf) books and download them to the BI X Series wirelessly. Newspapers and magazines are currently not available in the online search.
To activate the Bookshare service and download a book: 
· Enter your Bookshare account email address and password. 
· Select your preferred book format (DAISY or BRF).
· Search books by title, author, full text search, and/or browse by categories. You can also search for the most recent or popular books or by reading lists.
· Press Enter or a cursor routing key on a book to get more information. 
· Use Previous and Next thumb keys to navigate between the title, author, and book description. 
· Press Enter on the Download item to download the book to the BI X Series.
Note: on the Bookshare’s website, you can create reading lists to filter your preferred books and organize them by genre or custom categories. You can also join reading lists created by your friends or neighbors. If you want to delete a book from a reading list, when in the reading lists, select the list in which you wish to access. Then, select the book you want to delete by navigating to it then press Enter or a cursor-routing key. In the available options list, select the option to remove this book from the list and the operation will be done. It is also possible to add a book to the reading list. When positioned on that book, press Enter and, in the available options list, select the option to add this book to a reading list. Then, in the reading lists available to your account, select the list in which you want to add this book. The operation will be done and the book will be added to this list. Finally, public reading lists have also been created by the Bookshare team, organizing popular books by genre or categories. You can subscribe to them via the Bookshare website. However, it is impossible to add or remove books from a reading list created by the Bookshare team or created by an organization.
If you are a student and if your teacher wants you to read specific books, they can also assign you those books that will be available for you afterwards, in the “Assigned titles” category. 
18.2. [bookmark: _Toc209000195] Configuring, Managing, and Syncing an NFB Newsline Account
If you have an NFB Newsline® account, the BI X Series allows you to connect to your account and download NFB material for reading in the Victor Reader.
Configure account: Enter your NFB Newsline credentials, select the issue update frequency, and determine whether your BI X Series should keep or delete outdated issues.
Manage publications: Select which material you wish to subscribe to. Subscribed material is underlined.
Sync content now: Downloads the latest issues of your subscribed material.
18.3. [bookmark: _Toc209000196]NLS Bard
The BI X Series can access BARD directly. You can view and download books from the most popular books list and the most recent books and magazines list. You can browse subject categories and search the collection. You can also download books and magazines from your wish list as well as add and remove items from it. Before you can access BARD, you must connect your device to a Wi-Fi network (see section "Connecting your BI X Series to a Wi-Fi network" for detailed instructions) and login to your BARD account.
18.4. [bookmark: _Toc209000197]DAISY Online
DAISY online is a service that supports several libraries of adapted content across the world.
To access the DAISY Online libraries supported by the device, follow these steps: 
Note: to access DAISY online libraries, an Internet connection is required. 
· On the main menu, with the Previous and Next thumb keys, navigate until reaching the item “Online Services” and press Enter.
· Using the Previous and Next thumb keys, navigate to the DAISY online item, then press Enter.
You will now have a list of any of the DAISY Online accounts that you have previously configured, followed by the “Add account” item. If you did not configure any DAISY Online account, the “Add account” item will be the first one displayed when opening the DAISY Online application. You will have to add an account to see the list of available libraries. To do so, follow the instructions below.
18.4.1. [bookmark: _Toc209000198]Adding a DAISY Online account 
· From the main menu, with the Previous and Next thumb keys, navigate until reaching the item “Online Services” and press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter. 
· With the Previous and Next thumb keys, navigate until reaching the item “Add account”, then press Enter.
· The list of available libraries will be displayed. Select the one in which you have an account that you want to configure, then press Enter on this library.
· Enter the username for this account, then press Enter.
· Enter the password for this account, then press Enter.
If the connection is established, you will get the message “login successful” and a new account will be added to the list of already configured libraries that you will see when opening the DAISY Online app.
Note: when your cursor is on an already configured account, you can press the shortcut Space + M to go to the contextual menu. You will have the option to change the download method (automatic or manual), to modify login information, or to remove this specific account.
18.4.2. [bookmark: _Toc209000199]Import Configuration
In conjunction with the HumanWare Companion application, the BI X Series allows to import a library configuration from a XML file. This process requires both an active network connection and an XML file located on an external drive. To download the HumanWare companion, please visit https://support.humanware.com/en-international/support/humanware_companion

To import a configuration, do the following:
· On the main menu, using the Previous and Next thumb keys, navigate until reaching the item “Online services”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter.
· On the displayed menu, navigate with the Previous and Next thumb keys until reaching the item “Import configuration”, then press Enter. A message indicating the result of the import will be displayed. If the import is a success, one or more new configured accounts will be added to your device, depending on the information from the XML file.
18.4.3. [bookmark: _Toc209000200]Downloading a book from a DAISY Online library configured on your device
18.4.3.1.  Automatic download
By default, when adding a new account, the option “automatic download” is selected, meaning that the books present in the bookcase of this account are automatically downloaded when the BI X Series will be connected to a Wi-Fi network. To access to the downloaded books, do the following:
· On the main menu, navigate with the Previous and Next thumb keys until reaching the item “Online services”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the account previously configured, then press Enter.
· You can see the books, in this bookcase, that have been downloaded. The title of the book is displayed, followed by the mention “downloaded”. At that time, no action is required, as your books will continue to download automatically until the last one in the bookcase or until the memory of your BI X Series will be full.
· At any time, you can force the synchronization of your content. At the end of the book list, the option “Sync content now” is present. Press Enter on this option and the device will search for any new content in your account. A message indicating that no new content has been found or indicating the number of new elements found, if any, will be displayed, and the synchronization of these new elements will begin automatically.
18.4.3.2. Manual download
When configuring a new DAISY Online account, the option “automatic download” is configured by default. However, it is possible to change the download method if you prefer to download your books manually. To do so, do the following:
· On the main menu, navigate with the Previous and Next thumb keys until reaching the item “Online services”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the item “DAISY Online”, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the account configured that interests you. 
· Press Space + M to go to the contextual menu.
· With the Previous and Next thumb keys, navigate until reaching the item “Download method”, followed by the value of this element. Press Enter on this item.
· You will now have the choice between “automatic download” and “manual download”. With the Previous and Next thumb keys, navigate until reaching the option “Manual download”, then select it by pressing Enter.
With the manual download method, you will have to select manually the books that you want to download. To do so, do the following:
· On the main menu, use the Previous and Next thumb keys to go to the option “Online services”, then press Enter.
· In the displayed list, with the Previous and Next thumb keys, go to DAISY Online, then press Enter.
· A list of configured libraries on your device will be displayed. With the Previous and Next thumb keys, navigate until reaching the library that you have previously configured with the manual download method, then press Enter.
· You will see the list of already downloaded books, if any, and a “Download more books” option will be displayed at the end of the list. With the Previous and Next thumb keys, navigate until reaching the “Download more books” option, then press Enter.
· You will now have access to the books included in your bookcase for this account. With the Previous and Next thumb keys, go through the list and select the book that you want to download, then press Enter.
· With the Previous and Next thumb keys, navigate until reaching the option “Download”, then press Enter. The book will be placed in the download queue.
18.4.4. [bookmark: _Toc209000201]Reading a Book you have downloaded
After you have downloaded a book or magazine, you can download additional items, or you can read one of them. To read an item:
· Return to the Main Menu by pressing the Home button. 
· Navigate to Victor Reader and press Enter. 
· Press Enter on Book List. Here, you will find your downloaded items. 
· Press Enter on the title you wish to read and you will be at the beginning of the book.
Alternatively, when on the book list of a specific account in the DAISY Online app, you can press Enter on a book, which will display the available options, then select the “Open book” option and press Enter. The book will open in Victor Reader and the reading will begin, starting from the beginning of the book.
18.5. [bookmark: _Toc209000202]Eole
Eole is a French library that contains accessible books for disabled people. You can access that resource by using the following URL: https://eole.avh.asso.fr/ 
More information about EOLE library can be found in the French user guide of this device alternatively it can be downloaded from on our website.
19. [bookmark: _Toc209000203]Exam Mode
Exam Mode is used to block certain functions and applications from the BI X Series for a certain amount of time. While the Exam Mode is active, you will only have access to the Terminal functions. Note that in Exam Mode, the Bluetooth connection is deactivated and Terminal mode is only accessible via USB. All other applications and the use of an external memory (USB drive) are blocked while this mode is active.
When activating the Exam Mode, you will be prompted to enter a time between 1 and 360 minutes (6 hours) and will be asked to enter a desired password to turn off the exam mode. 
To unlock the device, you will need to either wait for the selected time to run out or enter the selected password. 
Upon restarting the device, if the period selected is not completed yet, the device will automatically go back to Exam Mode.
To activate the Exam Mode:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Go to Activate Exam Mode.
· Press Enter.
· Enter the desired time (between 1 and 360 minutes).
· Enter the desired password to activate the Exam Mode.
· Press Enter.
20. [bookmark: _17_Accessing_the][bookmark: _Accessing_the_diagnostic][bookmark: _Toc209000204]Accessing the diagnostic menu
The Diagnostic menu is a special menu used to test internal components and also to realize some key operations especially when troubleshooting issues that you could have while using the device. 
Here are the steps to access the Diagnostic menu:
· If your device is plugged into an energy source, please unplug it.
· If your device is running, press the Power button for two seconds. Your device will indicate “Shut down?”. With the Previous and Next thumb keys, navigate until reaching the OK button then press on any cursor-routing key to activate it. Your device will shut down.
· Press simultaneously the Power and the Volume up keys until your device indicates “Recovery mode”, then release the buttons. After a few seconds, the device will shutdown again.
· Boot the device normally by pressing the Power button for 2 seconds. The device will start again, and you will be directed to the Diagnostic menu.
You might need to use the diagnostic menu for the following operations:
· Factory reset
· Clear user data
· Clear user configuration
· Activate or de-activate Terminal only 
· Export logs when troubleshooting issues
· Exporting and importing data and configurations (see section 19.1 “Exporting and importing data and configurations” to know more).
Press on any cursor-routing key on the desired option to select it. Then, navigate with the Previous and Next thumb keys to reach the Close button and press on any cursor-routing key to select it. Your device will shutdown. Alternatively, you can close the diagnostic menu with the shortcut Space + E. 
Please note: some of the options in this menu are irreversible: the factory reset, the clear user data and the clear user configuration. When done, it is impossible to recover the content deleted.
20.1. [bookmark: _Exporting_and_importing][bookmark: _Toc209000205]Exporting and importing user data and configurations
The BI X Series contains an export and import utility both for your data and configurations such as Wi-Fi and library credentials. There are several reasons why you would import and export. 
· Transferring your data to another device. Very useful if you have a care plan 
· General backup.
These options can only be accessed using the diagnostic menu. There are two types of export/import options to be aware of: 
· Export/import Configurations: This option refers to Wi-Fi and online book credentials. It will not, however export any Bluetooth configuration. 
· Export/import user content: This option refers to user data. This includes newly created folders and files. It will also export any books downloaded from the current library providers. (This could be subject to change on new any future libraries added. You cannot export data and configurations for DAISY Online libraries. 
To export configuration or user content:
· Access the diagnostic menu. Now make sure to insert a USB thumb drive or an SD card (BI 20X only); this is where you will export the data to. 
· There are several items in the Diagnostic menu. Depending on what you wish to export, use your Next thumb key to move to the item called either “Export configuration or Export user content”. 
· Press Enter or any cursor-routing key on your selected item. 
· You will now be prompted “Please wait” followed by “Export to USB done” or “Export to SD done” shortly after. 
· When the operation is finished, please shutdown your device by navigating with the Previous and Next thumb keys until reaching the Close button then press Enter or any cursor-routing key on it, or you can close the diagnostic menu with the shortcut Space + E.
Note: The exported configuration cannot be opened on a computer. 

To import configuration or user content:
· To import user content or configurations, you will once again need to boot the BI X Series in diagnostic menu.
· Insert the USB thumb drive or the SD card (BI 20X only), which contains the file to import. 
· Using your Previous and Next thumb keys, move to the item called either “Import configuration or Import user content” then press Enter. 
· You will be prompted “Please wait” followed shortly by “Import done”. 
· After the completion of the operation, please close the device by navigating with the Previous and Next thumb keys until reaching the Close button then press on Enter or any cursor-routing key. Alternatively, you can also close the device with the shortcut Space + E.
Important Note: All recently created content or editing of existing content made after the export file was generated will be deleted.

21. [bookmark: _Toc209000206]Technical Specifications
21.1. [bookmark: _Toc209000207]Navigation components
· 4 Thumb keys
· 8-key Braille keyboard
· 2 Space bars
· Cursor routing keys
· 6 Command keys (BI 40X only)
21.2. [bookmark: _Toc209000208]Long-life battery
· Lasts up to 20 hours
· Recharges from PC through USB port
· Auto shut-off
· Lithium-ion polymer battery
· Compatible with any standard USB A/C adapter
21.3. [bookmark: _Toc209000209]Connectivity
· USB 2.0
· SD card (BI 20X only)
· Wi-Fi 2.4 GHz & 5 GHz (BI 40X), Wi-Fi 2.4 GHz (BI 20X)
· Bluetooth V5 (BI 40X), Bluetooth V4.2 (BI 20X)
21.4. [bookmark: _Toc209000210]Portability
Dimensions: 305 mm x 90 mm x 21.8 mm (BI 40X), 93 mm x 182 mm x 23 mm (BI 20X)
Weight: 720 g (BI 40X), 400 g (BI 20X) 
22. [bookmark: _Toc209000211]Updating the BI X Series
22.1. [bookmark: _Toc209000212]Updating the BI X Series manually
When connected to the Internet with the BI X Series, you can manually check if an update is available. 
To check for an update manually:
· Go to the Main menu.
· Select Options.
· Press Enter. 
· Select Software update.
· Press Enter.
· Select Check for update.
· Press Enter.

If prompted with a new update, select Download by pressing the Previous or Next thumb key to download the update now or Remind me later to update it later. You can continue to use the BI X Series while the update is downloading.
Note that the device must be plugged in and the battery must be more than 50% charged for the update to be performed.
After a few minutes, BI X Series asks you to install the downloaded update. Select Ok to install it. The device reboots and a progress indicator line is shown on the braille display. 
At the end of the update process, all 8 dots of all braille cells raise one column at a time and then the device shuts down.
22.2. [bookmark: _Toc209000213]Updating the BI X series via USB or SD card (BI 20X only)
You can update the BI X Series by downloading the update file on a computer and transferring it on a USB flash drive or an SD card (BI 20X only). To update the BI X Series via USB or an SD card:
· Insert a USB flash drive or SD card into your computer. 
· Transfer the update file to the USB flash drive or the SD card. Note that the update file needs to be placed at the root of the USB drive or SD card.
· Insert the USB flash drive or SD card containing the update file into your BI X Series. Make sure your device is powered on.
· When the BI X Series detects an update file on the USB drive or SD card, the braille display will prompt that an update is available for installation. 
· Press the Next thumb key to reach the Ok item, and press Enter to activate the update prompted. The device will shut down and restart to process the update.
The latest update is always available on the Brailliant BI 20X or Brailliant BI 40X product page.
22.3. [bookmark: _Toc209000214]Automatic Check for Update Feature
By default, an Automatic check for update feature is enabled. When connected to the internet, the BI X Series regularly looks if a new update is available for download. If an update is available, the BI X Series will prompt you to download it. 
To disable/enable the Automatic check for update feature, follow these steps:
· Go to the Main menu.
· Select Options.
· Press Enter.
· Go to Software Update.
· Press Enter.
· Select Automatic check for updates.
· Press Enter to enable/disable the feature.
Note that when enabled, the BI X Series will check every 23 hours if a new update is available.
23. [bookmark: _Toc209000215]Customer Support
For customer support, please contact the HumanWare office nearest you or visit our Website at: www.humanware.com/support
Global: support@humanware.com
North America: 1 800 722-3393
us.support@humanware.com
Europe: (0044) 1933 415 800
eu.support@humanware.com
Australia / Asia: (02) 9686 2600
au.sales@humanware.com
24. [bookmark: _Toc209000216]Proper Trademark Notice and Attributions 
macOS is a registered trademark of Apple Inc. 
JAWS is a registered trademark of Freedom Scientific, Inc. in the United States and other countries.
Bookshare® is a registered trademarks of Beneficent Technology, Inc. 
NFB Newsline is a registered trademark of the National Federation of the Blind
Bluetooth is a registered trademark of Bluetooth SIG, Inc. 
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license. 
All other trademarks are the property of their respective owners. 
25. [bookmark: _Toc209000217]End User License Agreement
By using this Product (BI X Series), you agree to the following minimum terms:
0. License Grant. HumanWare grants to End User a non-exclusive, non-transferable right and license to use the Software on this product.
0. Ownership of Software. End User acknowledges that HumanWare retain all right, title and interest in and to the original, and any copies, of software which is incorporated into this product. End User agrees not to: modify, port, translate, decompile, disassemble, reverse engineer, or make public in any way the software of this Product.
26. [bookmark: _Toc209000218]Warranty
Manufacturer Warranty
This device is a high-quality product, built and packaged with care. All units and components are guaranteed against any operational defects for 2 years for all countries.
Warranty covers all parts (except battery) and labor. If any defect should occur, please contact your local distributor or the manufacturer technical assistance line.
Note: Warranty terms may periodically change, please consult our website for the latest information.
Conditions and Limitations:
Please keep your bill of purchase in a safe place as it may be required for a warranty repair or replacement. Please retain your original. If the unit has to be returned, please use the original packaging. This warranty applies to all cases where the damage is not a result of improper use, mistreatment, negligence or acts of God.
North America: In addition to the warranty, you can also purchase a Service Contract to prolong coverage for one year and also benefit from the cleaning service. Please refer to our web site: http://www.humanware.com/  
Or contact us by E-mail at us.info@humanware.com or call 1(800) 722-3393


[bookmark: _Toc209000219]Appendix A – Command Summary
Note: All commands that include Enter or Backspace must have the Space Bar added to them when using computer braille.
[bookmark: _Toc209000220]Shortcut/Key Combination Table
	Action
	Shortcut or Key Combination

	Activate Selected item
	Enter or cursor routing key

	Escape or Back
	Space + E

	Previous item
	Previous thumb key, C1 or Space + Dot 1

	Next item
	Next thumb key, C3 or Space + Dot 4

	Jump to any item in a list
	Type the first letter of the item or app

	Pan left and right
	Left or Right thumb key or C2 (pan left) and C5 (pan right)

	Go to top
	Space + Dots 1-2-3

	Go to bottom
	Space + Dots 4-5-6

	Toggle Braille grade
	Backspace + G

	Switch language profile
	Enter + L or C4 

	Battery level
	Enter + P

	Context menu
	Space + M

	Main menu
	Space + Dots 1-2-3-4-5-6 or Home button

	System information
	Space + I

	Time
	Enter + T

	Date
	Enter + D

	Eject media
	Enter + E

	Options
	Space + O

	Create a quick note
	Backspace + N

	Create a quick braille note
	Backspace + B

	Toggle speech on/off
	Space + Previous Thumb Key

	Increase speech rate
	Enter + Dot 5

	Decrease speech rate
	Enter + Dot 2

	Open Terminal
	Backspace + Enter + T

	Open KeyPad
	Backspace + Enter + E

	Open KeyRecorder
	Backspace + Enter + R

	Record note
	Enter + N

	Stop recording
	Enter + X

	Pause/Resume recording
	Backspace + Enter

	Cancel recording
	Space + E

	Open Victor Reader
	Backspace + Enter + V

	Open KeyFiles 
	Backspace + Enter + F

	Open KeyCalc
	Backspace + Enter + C

	Open Bookshare
	Backspace + Enter + B

	Open NFB Newsline
	Backspace + Enter + W

	Open NLS Bard
	Backspace + Enter + N

	Search for Wi-Fi
	Backspace + Enter + S

	Help
	Space + H

	List all the paired audio devices
	Backspace + Enter + A



[bookmark: _Toc209000221]KeyPad Commands
	Action
	Shortcut or Key Combination

	Activate edit mode
	Enter or a cursor routing key

	Leave edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/Stop selection
	Enter + S

	Select all 
	Enter + Dots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Enter + Dots 1-2-4-5-6 or C6

	Increase auto-scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop the text-to-speech
	Backspace + Enter

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + Dots 2-5-6

	Search in WordNet
	Space + D

	Toggle Reading mode 
	Space + X

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B



[bookmark: _Toc209000222]KeyBrf Commands
	Action
	Shortcut or Key Combination

	Activate Edit mode
	Enter or a cursor-routing key

	Leave Edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/stop selection
	Enter + S

	Select all 
	Enter + A

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	Space + Dots 1-2-4-5-6

	Increase Auto-Scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + Dots 2-5-6

	Search in WordNet
	Space + D

	Toggle Reading mode 
	Space + X

	Where Am I? (Format BRF option  On)
	Space + Dots 1-5-6

	Preview mode (Format BRF option  On)
	Enter + V

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Bookmark
	Enter + B



[bookmark: _Toc209000223]KeyRecorder commands 
	Action
	Shortcut or key combination

	Record note
	Enter + N

	Stop recording
	Enter + X

	Pause/Resume recording
	Backspace + Enter

	Cancel recording
	Space + E

	Go to
	Enter + G

	Where Am I?
	Space + Dots 1-5-6

	Play/Pause
	Space + G

	Increase speed
	Enter + Dot 5

	Decrease speed
	Enter + Dot 2

	Info (about a note file)
	Space + I

	Rename (a note file)
	Backspace + R

	Delete (a note file)
	Backspace + Dots 2-3-5-6


[bookmark: _Toc209000224]Victor Reader/Reading Commands for textbooks
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation level
	Space + T

	Previous Navigation level
	Backspace + Dot 3

	Next Navigation level
	Backspace + Dot 6

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Start Auto-scroll
	Enter + Dots 1-2-4-5-6 or C6

	Increase Auto-scroll speed
	Enter + Dot 6

	Decrease Auto-scroll speed
	Enter + Dot 3

	Read all (text-to-speech feature)
	Space + G

	Stop reading (text-to-speech feature)
	Backspace + Enter

	Where am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Search for books or text
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Next non-blank line
	Enter + Dot 4

	Previous non-blank line
	Enter + Dot 1

	Previous character
	Space + Dot 3

	Next character
	Space + Dot 6 

	Previous word
	Space + Dot 2

	Next word
	Space + Dot 5

	Previous paragraph
	Space + Dots 2-3

	Next paragraph
	Space + Dots 5-6

	Start/Stop selection
	Enter + S

	Select all (current paragraph)
	Enter + Dots 1-2-3-4-5-6

	Copy (current paragraph)
	Backspace + Y

	Delete book
	Backspace  + Dots 2-3-5-6

	Search on Wikipedia
	Enter + W

	Search on Wiktionary
	Enter + Dots 2-5-6

	Search in WordNet
	Space + D



[bookmark: _Toc209000225]Victor Reader Commands for audiobooks
	Action
	Shortcut or Key Combination

	Switch from text to audio content (when in a DAISY/NISO book containing the full text and audio content)
	Space + Dots 2-3-5-6

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation Level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Change to previous Navigation level
	Backspace + Dot 3

	Change to next Navigation level
	Backspace + Dot 6

	Where Am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Delete book
	Backspace + Dots 2-3-5-6

	Play audiobook
	Space + G

	Stop the reading
	Backspace + Enter

	Fast forward 5 seconds
	Right thumb key (single press)

	Rewind 5 seconds 
	Left thumb Key (single press)

	Fast forward (Longer time jumps)
	Right thumb key (press and hold)

	Rewind (Longer time jumps)
	Left thumb key (press and hold)

	Increase reading speed
	Enter + Dot 5

	Decrease reading speed
	Enter + Dot 2



[bookmark: _Toc209000226]KeyFiles Commands
	Action
	Shortcut or Key Combination

	Create new folder 
	Space + N

	File/drive info 
	Space + I

	Mark/Unmark
	Backspace + L

	Mark all/Unmark all 
	Enter + Dots 1-2-3-4-5-6

	Rename file
	Backspace + R

	Delete file
	Backspace + Dots 2-3-5-6

	Copy file 
	Backspace + Y

	Cut file
	Backspace + X

	Paste file
	Backspace + V

	Search file 
	Space + F

	Sort files 
	Space + V

	Where am I 
	Space + Dots 1-5-6

	Select drive 
	Space + D

	Go to parent folder
	Space + E

	Eject media
	Enter + E



[bookmark: _Toc209000227]Calculator Commands using US Computer Braille
	Action
	Shortcut or Key Combination

	Plus 
	Dots 3-4-6

	Minus
	Dots 3-6

	Multiply
	Dots 1-6

	Divide
	Dots 3-4

	Equals
	Enter

	Clear 
	Space + Dots 3-5-6

	Decimal point
	Dots 4-6

	Percent
	Dots 1-4-6

	Square root 
	Space + Dots 3-4-5

	Pi
	Space + Y





[bookmark: _Toc209000228]Appendix B – Braille Tables
[bookmark: _Toc209000229]United States 8 dot Computer Braille
exclamation mark: '!' 2,3,4,6
quote: '"' 5
pound: '#' 3,4,5,6
dollar sign: '$' 1,2,4,6
percent: '%' 1,4,6
ampersand: '&' 1,2,3,4,6
apostrophe: ''' 3
left paren: '(' 1,2,3,5,6
right paren: ')' 2,3,4,5,6
asterisk: '*' 1,6
plus sign: '+' 3,4,6
comma: ',' 6
dash: ' ' 3,6
period: '.' 4,6
forward slash: '/' 3,4
colon: ':' 1,5,6
semi colon: ';' 5,6
less than: '<' 1,2,6
equals: '=' 1,2,3,4,5,6
greater than: '>' 3,4,5
question mark: '?' 1,4,5,6
at symbol: '@' 4,7
left square bracket: '[' 2,4,6,7
back slash: '\' 1,2,5,6,7
right square bracket: ']' 1,2,4,5,6,7
carat sign: '^' 4,5,7

underscore: '_' 4,5,6
grave accent: '`' 4
left curly bracket: '{' 2,4,6
vertical bar: '|' 1,2,5,6
right curly bracket: '}' 1,2,4,5,6
tilde: '~' 4,5
'0': 3,5,6
'1': 2
'2': 2,3
'3': 2,5
'4': 2,5,6
'5': 2,6
'6': 2,3,5
'7': 2,3,5,6
'8': 2,3,6
'9': 3,5
Uppercase letters:
'A': 1,7
'B': 1,2,7
'C': 1,4,7
'D': 1,4,5,7
'E': 1,5,7
'F': 1,2,4,7
'G': 1,2,4,5,7
'H': 1,2,5,7
'I': 2,4,7
'J': 2,4,5,7
'K': 1,3,7
'L': 1,2,3,7
'M': 1,3,4,7
'N': 1,3,4,5,7
'O': 1,3,5,7
'P': 1,2,3,4,7
'Q': 1,2,3,4,5,7
'R': 1,2,3,5,7
'S': 2,3,4,7
'T': 2,3,4,5,7
'U': 1,3,6,7
'V': 1,2,3,6,7
'W': 2,4,5,6,7
'X': 1,3,4,6,7
'Y': 1,3,4,5,6,7
'Z': 1,3,5,6,7
Lowercase letters:
'a': 1
'b': 1,2
'c': 1,4
'd': 1,4,5
'e': 1,5
'f': 1,2,4
'g': 1,2,4,5
'h': 1,2,5
'i': 2,4
'j': 2,4,5
'k': 1,3
'l': 1,2,3
'm': 1,3,4
'n': 1,3,4,5
'o': 1,3,5
'p': 1,2,3,4
'q': 1,2,3,4,5
'r': 1,2,3,5
's': 2,3,4
't': 2,3,4,5
'u': 1,3,6
'v': 1,2,3,6
'w': 2,4,5,6
'x': 1,3,4,6
'y': 1,3,4,5,6
'z': 1,3,5,6

[bookmark: _Toc209000230]United Kingdom 8 dot Computer Braille
exclamation mark: '!': 2,3,4,6
quote: '"' 4
pound: '#' 5,6
dollar sign: '$' 4,5,6
percent: '%' 4,6
ampersand: '&' 1,2,3,4,6
apostrophe: ''' 3
left paren: '(' 4,5
right paren: ')' 3,4,5
asterisk: '*' 3,5
plus sign: '+' 2,3,5
comma: ',' 2
dash: ' ' 3,6
period: '.' 2,5,6
forward slash: '/' 3,4
colon: ':' 2,5
semi colon: ';' 2,3
less than: '<' 2,3,6
equals: '=' 2,3,5,6
greater than: '>' 3,5,6
question mark: '?' 2,6
at symbol: '@' 2,3,4,6,7
left square bracket: '[' 1,2,3,5,6,7
back slash: '\' 5,7
right square bracket: ']' 2,3,4,5,6,7
carat sign: '^' 6,7
underscore: '_' 3,4,6
grave accent: '`' 2,3,4,6
left curly bracket: '{' 1,2,3,5,6
vertical bar: '|' 5
right curly bracket: '}' 2,3,4,5,6
tilde: '~' 6
Pounds sterling: '£' 2,3,6,7,8
degree sign: '°' 1,3,4,6,8
'0': 1,2,3,4,5,6
'1': 1,6
'2': 1,2,6
'3': 1,4,6
'4': 1,4,5,6
'5': 1,5,6
'6': 1,2,4,6
'7': 1,2,4,5,6
'8': 1,2,5,6
'9': 2,4,6
Uppercase letters:
'A': 1,7
'B': 1,2,7
'C': 1,4,7
'D': 1,4,5,7
'E': 1,5,7
'F': 1,2,4,7
'G': 1,2,4,5,7
'H': 1,2,5,7
'I': 2,4,7
'J': 2,4,5,7
'K': 1,3,7
'L': 1,2,3,7
'M': 1,3,4,7
'N': 1,3,4,5,7
'O': 1,3,5,7
'P': 1,2,3,4,7
'Q': 1,2,3,4,5,7
'R': 1,2,3,5,7
'S': 2,3,4,7
'T': 2,3,4,5,7
'U': 1,3,6,7
'V': 1,2,3,6,7
'W': 2,4,5,6,7
'X': 1,3,4,6,7
'Y': 1,3,4,5,6,7
'Z': 1,3,5,6,7
Lowercase letters:
'a': 1
'b': 1,2
'c': 1,4
'd': 1,4,5
'e': 1,5
'f': 1,2,4
'g': 1,2,4,5
'h': 1,2,5
'i': 2,4
'j': 2,4,5
'k': 1,3
'l': 1,2,3
'm': 1,3,4
'n': 1,3,4,5
'o': 1,3,5
'p': 1,2,3,4
'q': 1,2,3,4,5
'r': 1,2,3,5
's': 2,3,4
't': 2,3,4,5
'u': 1,3,6
'v': 1,2,3,6
'w': 2,4,5,6
'x': 1,3,4,6
'y': 1,3,4,5,6
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